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INTRODUCTION 

DIABETES MELLITUS  

  Diabetes mellitus is a disorder that affects the body’s ability to make or use insulin. 

Insulin is a hormone produced in the pancreas that helps transport glucose (blood 

sugar) from the bloodstream into the cells so they can break it down and use it for 

fuel. People cannot live without insulin. Diabetes results in abnormal levels of 

glucose in the bloodstream. This can cause severe short-term and long- term 

consequences ranging from brain damage to amputations and heart disease. 

 

Diabetes mellitus is a clinical syndrome characterized by inappropriate 

hyperglycaemia caused by a relative or absolute deficiency of insulin or by a 

resistance to the action of insulin at the cellular level. It is the most common 

endocrine disorder, affecting 16 million individuals in the United States and as many 

as 200 million worldwide. The primary defect in fuel metabolism results in 

widespread, multi-organ complications that ultimately encompass virtually every 

system of the body and every specialty of medicine. It has been said that to know 

diabetes is to know medicine and health care. Although from a clinical standpoint this 

may be true, our increasing knowledge of the pathophysiology of the syndrome, 

together with the mechanisms of long- term complications, has placed diabetes 

research at the frontier of immunology and molecular biology.
1
 

 

Fig. no: 1 Statistics of different countries living with diabetes 
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ROOT CAUSES OF DIABETES MELLITUS (DM) 

The root causes of diabetes are complex. Most cases begin with one of two processes: 

Metabolic: Unhealthy lifestyle factors such as over- eating, physical inactivity and 

obesity can impair the body’s ability to use insulin. This is called insulin resistance. 

Uncontrollable risk factors including genetics, family history and age can also be 

involved. Metabolic forms of diabetes include: 

Type 2 diabetes: This accounts for 90 - 95% of diabetic cases, according to the U.S. 

National Institutes of Health (NIH). Some of these patients have had prediabetes that 

went uncontrolled. Once considered a disease of middle and old age, type 2 is also 

becoming more common in youths as the incidence of childhood obesity grows. 

Gestational diabetes: Hormonal changes contribute to this condition which can 

develop in any previously non- diabetic woman during pregnancy, especially those 

who are overweight. 

 

AUTOIMMUNE 

The body’s immune system can mistakenly destroy the insulin-producing beta cells 

of the pancreas. The causes of autoimmune diabetes are poorly understood, but 

genetics and family history play a role, and viruses or other environmental factors 

are believed to figure in. Autoimmune forms of diabetes include: 

    Type 1 diabetes: Formerly known as juvenile diabetes, this form generally develops 

in children and young adults. 

Latent autoimmune diabetes of adulthood: This variation of type 1 can occur later 

in life. Individuals with auto- immune diabetes who overeat, are sedentary, gain 

weight or have certain genes can, like people with metabolic forms of diabetes, 

develop insulin resistance. This state is known as double diabetes. 

Diabetes can also result from another disease, such as pancreatitis, or even from a 

medical treatment, including pancreatectomy (surgical removal of the pancreas) or 

certain medications. This is known as secondary diabetes. In addition, there are 

uncommon inherited disorders that cause diabetes, such as maturity-onset diabetes of 

the young and Wolfram syndrome. Most cases of diabetes last the rest of a person’s 

life. However, gestational diabetes generally ends when the pregnancy does, and 

some cases of secondary diabetes are also temporary 
2
. 

 



                                                                                      INTRODUCTION 

 

Department Of Pharmaceutical Chemistry, MMC. Page 3 
 

FACTORS CONTRIBUTE IN DIABETES  

 

Diabetes involves chronic levels of abnormally high glucose (hyperglycemia). Many 

patients, especially those with type 2 diabetes, also have elevated blood pressure 

(hypertension), chronic high levels of insulin (hyperinsulinemia) and unhealthy levels 

of cholesterol and other blood fats (hyperlipidemia).
3,4

 All of these factors contribute 

to the long-term complications of diabetes, which include: 

Vascular disease (diabetic angiopathy), atherosclerosis, heart conditions and 

stroke: These cardiovascular disorders are the leading cause of death in people with 

diabetes. 

Kidney disease (diabetic nephropathy): Diabetes is the chief cause of end-stage 

renal disease, which requires treatment with dialysis or a kidney transplant. 

Eye diseases: These include diabetic retinopathy, glaucoma and cataracts. Diabetes is 

a leading cause of visual impairment and blindness. 

Nerve damage (diabetic neuropathy): This includes peripheral neuropathy, which 

often causes pain or numbness in the limbs, and autonomic neuropathy, which can 

impede digestion (gastroparesis) and contribute to sexual dysfunction and 

incontinence. Neuropathy may also impair hearing and other senses. 

Infections and wounds: Foot conditions and skin disorders, such as ulcers, make 

diabetes the leading cause of nontraumatic foot and leg amputations. People with 

diabetes are also prone to infections including periodontal disease, thrush, urinary 

tract infections and yeast infections. 

Cancer: Diabetes increases the risk of malignant tumors in the colon, pancreas, liver 

and several other organs. 

Musculoskeletal disorders: Conditions ranging from gout to osteoporosis to 

restless legs syndrome to myofascial pain syndrome are more common in diabetic 

patients than nondiabetics. 

Pregnancy complications: Diabetes increases the risk of preeclampsia, miscarriage, 

stillbirth and birth defects. 

Emotional difficulties: Many but not all of the studies exploring connections 

between diabetes and mental illness have found increased rates of depression, 

anxiety and other psychological disorders in diabetic patients. In addition to chronic 

hyperglycemia, diabetic patients can experience acute episodes of hyperglycemia as 
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well as hypoglycemia (low glucose). Severe cases can cause seizures, brain damage 

and a potentially fatal diabetic coma. Acute glucose emergencies include: 

Diabetic ketoacidosis: A lack of insulin can force the body to burn fats instead of 

glucose for energy. The result is a toxic byproduct called ketones, along with severe 

hyperglycemia. 

Hyperosmolar hyperglycemic nonketotic state: This involves severe 

hyperglycemia and dehydration. 

These dangerous glucose complications are most common in patients with unstable 

diabetes, but they can develop even in individuals who do not realize they have 

diabetes. About one-third of the estimated 20.8 million Americans with diabetes have 

not yet been diagnosed, according to the U.S. Centers for Disease Control and 

Prevention. 

INCIDENCE OF DIABETES MELLITUS 

The incidence of diabetes has soared worldwide in recent years and is expected to 

keep growing, with the greatest increase seen in metabolic forms of diabetes, notably 

type 2. This is blamed largely on the rise of obesity and the global spread of Western-

style habits: physical inactivity along with a diet that is high in calories, processed 

carbohydrates and saturated fats and insufficient in fiber- rich whole foods. The aging 

of the population is also a factor. However, other factors, such as environment may 

also be contributing, because cases of autoimmune diabetes (type 1) are also 

becoming more common. 

The estimated number of people with diabetes has jumped from 30 million in 1985 

to 150 million in 2000 and then to 246 million in 2007, according to the International 

Diabetes Federation. It expects this number to hit 380 million by 2025. Seven 

percent of Americans have diabetes, according to the CDC, which predicts that one 

in three Americans born in 2000 will eventually become diabetic. Health agencies 

are warning that diabetes is a becoming an unprecedented epidemic even as other 

major diseases including cancer and nondiabetic heart disease are being controlled 
5
. 
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   Fig. no: 2   Global cause of death across the world. 

  

TYPES AND DIFFERENCES OF DIABETES 

 There are several forms of diabetes. Scientists are still defining and categorizing some 

of these variations and establishing their prevalence in the population. Types of 

diabetes include: 

 Type 1 diabetes: An autoimmune disease in which the immune system mistakenly 

destroys the insulin-making beta cells of the pancreas. It typically develops more 

quickly than other forms of diabetes. It is usually diagnosed in children and 

adolescents, and sometimes in young adults. To survive, patients must administer 

insulin medication regularly. 

 Type 1diabetes used to be called juvenile diabetes and insulin-dependent diabetes 

mellitus (IDDM). However, those terms are not accurate because children can 

develop other forms of diabetes, adults sometimes develop type 1, and other forms of 

diabetes can require insulin therapy. 

A variation of type 1 that develops later in life, usually after age 30, is called latent 

autoimmune diabetes of adulthood (LADA). 

  Sometimes patients with autoimmune diabetes develop insulin resistance because of 

weight gain or genetic factors. This condition is known as double diabetes. 
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 Type 2 diabetes: A disorder of metabolism, usually involving excess weight and 

insulin resistance. In these patients, the pancreas makes insulin initially, but the body 

has trouble using this glucose-controlling hormone. Eventually the pancreas cannot 

produce enough insulin to respond to the body’s need for it. Type 2 diabetes is by far 

the most common form of diabetes, accounting for 85 to 95% of cases in developed 

nations and an even higher percentage in developing nations, according to the 

International Diabetes Federation. 

This disease may take years or decades to develop. It is usually preceded by 

prediabetes, in which levels of glucose (blood sugar) are above normal but not high 

enough yet for a diagnosis of diabetes. People with pre- diabetes can often delay or 

prevent the escalation to type 2 diabetes by losing weight through improvements in 

exercise and diet, as the Diabetes Prevention Program and other research projects 

have demonstrated. 

  Type 2 diabetes used to be called adult-onset diabetes and non-insulin-dependent 

diabetes mellitus (NIDDM). Those terms are not accurate because children can also 

develop this disease, and some patients require insulin therapy. 

  Gestational diabetes: A temporary metabolic disorder that any previously 

nondiabetic woman can develop during pregnancy, usually the third trimester. 

Hormonal changes contribute to this disease, along with excess weight and family 

history of diabetes. About 4% of pregnant women develop gestational diabetes, 

according to the American Diabetes Association. 

  Gestational diabetes can cause problems for the mother and baby, including 

preeclampsia, premature delivery, macrosomia (oversized infant), and jaundice and 

breathing difficulties in the infant. This disease typically ends when the pregnancy 

does, but it increases the risk of type 2 diabetes later in life for the mother and the 

child. 

  Secondary diabetes: Diabetes caused by another condition. The many potential 

sources of secondary diabetes range from diseases such as pancreatitis, cystic fibrosis, 

Down syndrome and hemochromatosis to medical treatments including 

corticosteroids, other immune suppre-ssives, diuretics and pancreatectomy. 

Maturity onset diabetes of the young (MODY). An uncommon disease caused by a 

genetic defect inherited from a parent. It is usually diagnosed before age 25 in 

people of normal weight. MODY is sometimes classified as a form of type 2 or 

secondary diabetes but is often considered a separate condition 
6
.  
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RISK FACTORS AND CAUSES OF DIABETES 

 The causes of diabetes are complex and only partly understood. This disease is 

generally considered multi- factorial, involving several predisposing conditions and 

risk factors. In many cases genetics, habits and environment may all contribute to a 

person’s diabetes. 

  

  To complicate matters, there can be contrary risk factors for the various forms of the 

disease. For example, autoimmune diabetes (type 1 and latent autoimmune diabetes 

of adulthood, LADA) is more common in white people, but metabolic diabetes (type 

2 and gestational diabetes) is more common in people of other races and ethnicities. 

Type 1 is usually diagnosed in children, but advancing age is a risk factor for type 2 

and gestational diabetes.   Insulin resistance, prediabetes and metabolic syndrome are 

strong risk factors for type 2 diabetes. Other diabetic risk factors and causes include: 

 

Genetics and family history: Certain genes are known to cause maturity-onset 

diabetes of the young (MODY) and Wolfram syndrome. Genes also contribute to 

other forms of diabetes, including types 1 and 2. 

 

Family medical history is also influential to varying degrees:  

For example, a person whose parents both have type 1 diabetes has a 10 to 25% 

chance of developing that disease, according to the American Diabetes Association, 

and someone whose parents both have type 2 diabetes has a 50% chance of 

developing that disease. 

   

Weight and body type: Overweight and obesity are leading factors in type 2 diabetes 

and gestational diabetes. Excess fat, especially around the abdomen (central obesity), 

promotes insulin resistance and metabolic syndrome 
7
. 
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 SIGNS AND SYMPTOMS OF DIABETES  

Diabetes often goes undetected because symptoms can be attributed to many other 

causes and some patients experience no symptoms or fail to heed warning signs. 

Possible indicators of diabetes include 
8
: 

- Excessive thirst (polydipsia) 

- Excessive urination (polyuria) and dehydration 

- Excessive hunger or appetite (polyphagia) 

- Unexplained weight loss 

- Blurred vision, nearsightedness or other vision problems 

- Frequent infections, including skin infections, thrush, gingivitis, urinary tract          

infections and yeast infections, Slow healing of sores, skin problems, such as 

itchiness or acanthosis nigricans  

- Fatigue, lethargy or drowsiness 

-  Shakiness or trembling 

-  Mood swings or irritability 

-   Dizziness or fainting , Numbness, tingling or pain in the feet, legs or hands 

 

 

  Fig. no: 3 Complications of Type 2 diabetes 
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CURRENT MANAGEMENT OF TYPE 2 DIABETES 

The pharmacological management of type 2 diabetes is based on altering the effects 

of the ominous octet that lead to hyperglycaemia.
 
The eight pathophysiological 

mechanisms include reduced insulin secretion from pancreatic β cells, increased 

glucagon secretion from pancreatic α cells, increased hepatic glucose production, 

neurotransmitter dysfunction and insulin resistance in the brain, increased lipolysis, 

increased renal glucose reabsorption, reduced incretin effect in the small intestine and 

reduced glucose uptake in peripheral tissues such as skeletal muscle, liver and adipose 

tissue. Currently available glucose-lowering therapies target one or more of these key 

components 
9
. 

 

 

   Fig. no: 4 Mechanism and site of action of synthetic drugs 
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ROLE OF MEDICINAL PLANTS IN DIABETES MELLITUS 

In the last few years there has been an exponential growth in the field of herbal 

medicine and these drugs are gaining popularity both in developing and developed 

countries because of their natural origin and less side effects.. In Indian systems of 

medicine most practitioners formulate and dispense their own recipes. The World 

Health Organization (WHO) has listed 21,000 plants, which are used for medicinal 

purposes around the world. Among these 2500 species are in India, out of which 150 

species are used commercially on a fairly large scale. India is the largest producer of 

medicinal herbs and is called as botanical garden of the world. 

 

 

   Fig. no: 5 Scope of Herbal Medicines against various diseases. 

Medicinal plants are being looked up once again for the treatment of diabetes. Many 

conventional drugs have been derived from prototypic molecules in medicinal plants. 

Metformin exemplifies an efficacious oral glucose-lowering agent. Its development 

was based on the use of Galega officinalis to treat diabetes. Galega officinalis is rich 

in guanidine, the hypoglycemic component. Because guanidine is too toxic for 

clinical use, the alkyl biguanides synthalin A and synthalin B were introduced as oral 

anti-diabetic agents in Europe in the 1920s but were discontinued after insulin became 

more widely available. However, experience with guanidine and biguanides prompted 

the development of metformin. To date, over 400 traditional plant treatments for 

diabetes have been reported, although only a small number of these have received 
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scientific and medical evaluation to assess their efficacy. The hypoglycemic effect of 

some herbal extracts has been confirmed in human and animal models of type 2 

diabetes. The World Health Organization Expert Committee on diabetes has 

recommended that traditional medicinal herbs be further investigated 
10

. 

 

 

  Fig. no: 6 Medicinal plants with Antidiabetic activity 

Table no. 1. Indian medicinal plants with antidiabetic and related beneficial 

properties 

 

Medicinal Plants 

Ayurvedic/common 

name 

Antidiabetic and other beneficial effects in 

traditional medicine 

 

Annona squamosa 

Sugar apple Hypoglycemic and antihyperglycemic 

activities of ethanolic leaf-extract, 

Increased plasma insulin level
11, 12.

 

 

Artemisia pallens 

Davana Hypoglycemic, increases peripheral 

glucose utilization or inhibits glucose 

reabsorption 
13

. 

 

Areca catechu Supari Hypoglycemic 
14

  

 

Beta vulgaris Chukkander Increases glucose tolerance in OGTT 
15
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Boerhavia diffusa Punarnava Increase in hexokinase activity,decrease in 

glucose-6-phosphatase and fructose bis-

phosphatase activity, increase plasma 

insulin level, antioxidant  

Bombax ceiba Semul Hypoglycemic 
16

 

Butea 

monosperma 

Palasa Antihyperglycemic 
17

 

Camellia sinensis Tea Anti-hyperglycemic activity, antioxidant 

Capparis decidua Karir or Pinju Hypoglycemic, antioxidant, 

hypolipidaemic  

 

Caesalpinia 

bonducella 

Sagarghota, 

Fevernut 

Hypoglycemic, insulin secretagogue, 

hypolipidemic 
18,19

 

Coccinia indica Bimb or Kanturi Hypoglycemic  

 

Emblica officinalis Amla, Dhatriphala “Triphala” Decreases lipid peroxidation, 

antioxidant, hypoglycemic  

Enicostema 

littorale 

Krimihrita Increase hexokinase activity, Decrease 

glucose 6-phosphatase and fructose 1,6 

bisphosphatase activity. Dose dependent 

hypoglycemic activity 

Ficus bengalenesis Bur Hypoglycemic, antioxidant 

Gymnema 

sylvestre 

Gudmar or 

Merasingi 

Anti-hyperglycemic effect, hypolipidemic 

Hemidesmus 

indicus 

Anantamul Anti snake venom activity, anti-

inflammatory 

Hibiscus 

rosasinesis 

Gudhal or Jasson Initiates insulin release from pancreatic 

beta cells  

 Ipomoea batatas Sakkargand Reduces 

insulin resistance 

Momordica 

cymbalaria 

Kadavanchi Hypoglycemic, hypolipidemic 
20

 

Musa sapientum Banana Antihyperglycemic, antioxidant 
21,22
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Phaseolus vulgaris Hulga, white 

kidney bean 

Hypoglycemic, hypolipidemic, inhibit 

alpha amylase activity, antioxidant. 

Altered level of insulin receptor and 

GLUT-4 mRNA in skeletal muscle 
23

 

Salacia reticulata Vairi Inhibitory activity against sucrase, α-

glucosidase inhibitor 
24

 

Scoparia dulcis Sweet broomweed Insulin- secretagogue activity, 

antihyperlipidemic, hypoglycemic, 

antioxidant 
25,26,27

 

Swertia chirayita Chirata Stimulates insulin release from islets 
28,29 

Syzygium 

alternifolium 

Shahajire Hypoglycemic and antihyperglycemic 

Terminalia 

belerica 

Behada constituent of “Triphala” Antibacterial, 

hypoglycemic  

Vinca rosea Sadabahar Anti-hyperglycemic 
30 

Withania 

somnifera 

Ashvagandhawinter 

cherry 

Hypoglycemic, diuretic and 

hypocholesterolemic 
31

 

 

 

   Fig. no: 7 An approach of Medicinal Plants in Bio informatics and Drug Design 
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NATURAL PRODUCT DRUG DISCOVERY 

Current challenges to the use of natural products and difficulty in accepting their 

therapeutic efficacy include:   

(1) Lack of standardization procedures (2) Lack of isolation of pure chemical products 

or compounds (3) Lack of elucidation of biological mechanisms and rarely 

undergoing so-called controlled documented clinical trials according to “standards”. 

Historically, there is scientific evidence on the therapeutic efficacy of natural products 

and as previously mentioned this led to development of some blockbuster 

conventional medicines. Searching for new drug candidates from natural products is 

often made difficult by the complexity of the molecular mixtures. The therapeutic 

activity of plant extracts is usually because of the synergistic and simultaneous action 

of several chemicals. Given the complex nature of many diseases including cancer 

and degenerative diseases, it is not surprising that the reliance on single compound-

based drug discovery has failed to provide effective cures.  

Plant-based drug discovery therefore must start with a combinatorial approach when 

evaluating candidate compounds. The advent of novel technologies including 

quantum computing, profiling techniques, computational biology techniques, big data, 

microfluidics and artificial intelligence will enable scientists to use a combinatorial 

approach to harness the therapeutic properties of plant-based natural products and 

simultaneously study their molecular effects in physiological conditions.  

It is however possible that not all components of plant extracts have measurable 

effects. It has been suggested that one way to improve screening and simplify extracts 

is through the removal of possible interfering components such as polyphenolic 

tannins. There are several reported innovative strategies which can be used to achieve 

this and these include pre-fractionation and extraction methods such as semi-bionic 

extraction, supercritical fluid extraction, microwave-assisted, ultrasonic-assisted and 

enzyme-assisted extraction, molecular distillation methods and membrane separation 

technology can be used to extract natural compounds efficiently from plants. These 

extractions strategies have been shown to have similar simulation to traditional 

methods allowing the extraction process to get most compounds from the natural 

product 
32

. 
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Despite the presence of anti-diabetic drugs in the pharmaceutical market, the 

treatment of diabetes with medicinal plants is often successful. Herbal medicines and 

plant components with insignificant toxicity and no side effects are notable 

therapeutic options for the treatment of this disease around the world 
33

. The most 

common herbal active ingredients used in treating diabetes are flavonoids, tannins, 

phenolic, and alkaloids 
34

. Tannins improves the function of pancreatic Beta-cells and 

increases insulin secretion. Quercetin is an antioxidant that acts in several 

mechanisms related with the removal of oxygen radicals, so prevents lipid 

peroxidation and metal ion chelation. These factors are mostly responsible for the 

reduction or elimination of diabetes complications. Streptazotocin rats are the most 

common animal model used to investigate anti-diabetic activity of plant extracts. 

 

In this present research, A potent anti diabetic plant Merremia hederacea has been 

selected. The literatures pertaining to phytochemical and the antidiabetic activity of 

this plant are very scarce. Hence an attempt has been made to evaluate the in vitro 

and in vivo anti diabetic activity of Merremia hederacea and to isolate the active 

constituent responsible for anti diabetic activity. The isolated pure compound has 

been attempted for molecular docking analysis. 
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REVIEW OF LITERATURE 

           Phytochemical Review of Merremia hederecea 

 

1. Wang, Wen-qiong, Song, Wei-bin, Lan, Xiao-jing et al; (2014) Isolated five 

new pentasaccharide resin glycosides, named merremins A-E (1-5), two new 

pentasaccharide resin glycoside methyl esters, named merremins F and G (6, 

7), and four known resin glycosides, murucoidin IV, murucoidin V, 

stoloniferin IV, and murucoidin XVII, from the aerial parts of Merremia 

hederacea. This is the first report of resin glycosides obtained from M. 

hederacea. In addition, the new compounds can be divided into three types: 

those possessing an 18-membered ring (1-4), compound 5 with a 20-

membered ring, and those with an acyclic core (6, 7). Furthermore, the 

different types of resin glycosides were evaluated for their multidrug 

resistance reversal activities. Compounds 1, 5, 6, and murucoidin V were 

noncytotoxic and enhanced the cytotoxicity of vinblastine by 2.3-142.5-fold at 

25 µM. Compound 5 and murucoidin V, with 20-membered rings, were more 

active than compound 1, with an 18-membered ring 
35

. 

 

2. Charles A, Joseph M and Alex Ramani V; (2012) investigated the ethanolic 

extract of the medicinal plant Merremia hederacea, which contains alkaloids, 

steroids, carbohydrates, terpenoids, tannin, phenolic compounds and 

flavonoids and all of them were confirmed through phytochemical screening 

and GC-MS analysis. The phytoconstituents present in this medicinal plant 

have been found to be studied by standard methods 
36

. 

         Patent 

1. Shang Y ; (2016) Traditional Chinese medicine comprises 1-5 borneol, 1-5 

Chinese angelica, 7-13 pts. wt. pangolins, 3-7 pts. wt. salicylic acid, 1-5 pts. 

wt. bezoar, 13-17 pts. wt. sulfur, 10-20 pts. wt. butter, 5-10 pts. wt. ethanol, 1-

3 pts. wt. trichlorfon, 5-8 pts. wt. Merremia hederacea, 1-3 pts. wt. Hyssopus 

officinalis, 10-12 pts. wt. Hydrangea, 13-17 pts. wt. Thalictrum foliolosum and 

6-9 pts. wt. cortex acanthopanacis radicism The composition useful for 

treating scabies on head (claimed), clearing away heat, detoxifying, 
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eliminating dampness, treating paralysis, promoting blood circulation, 

removing blood stasis and providing bactericidal effect. 

 

2. Chen K ; (2016) A Chinese medicine contains 25 pts. wt. Sida alnifolia, 15 

pts. wt. Ixeris sonchifolia, 10 pts. wt. Prinsepia uniflora kernels, 25 pts. wt. 

Merremia hederacea, 10 pts. wt. Chenopodium glacum, 6 pts. wt. walking 

fern, 9 pts. wt. toothed clubmoss, 9 pts. wt. Chrysanthemum flower heads, and 

15 pts. wt. Murdannia loriformis grass. USE - Chinese medicine used for 

treating chronic lacrimal gland inflammation. ADVANTAGE - The Chinese 

medicine provides safe and effective treatment for chronic lacrimal gland 

inflammation 

 

3. Yang C; (2014) Prepared merremoside B by taking Merremia hederacea 

stem, crushing, adding 60-80% methanol solution in which added amount of 

methanol solution is 8-10 times amount of crushed M. hederacea, performing 

ultrasonication to extract for 2-3 times, filtering to obtain extracted liquid, 

adding activated carbon, bleaching, filtering to remove activated carbon, 

concentrating, putting in macroporous resin column, and adding 60-70 vol.% 

concentrated methanol solution in which added amount of methanol solution is 

4-8 times amount of liquid. ADVANTAGE - Preparation process is simple 

and generates less pollution. 

 

4. Zhang X; (2014) Investigated the chinese medicinal composition comprises 

(in pts.wt.): Eupatorium (20-30), Merremia hederacea (15-20), Astragalus 

root (10-15), Salvia miltiorrhiza root (12-18), Atractylodes rhizome (5-10), 

green tangerine orange peel (8-12), Stephania tetrandra root (15-20), Verbena 

(14-18), Polyporus (10-15), tangerine pith (5-10), Polygonatum rhizome (11-

17), Achyranthes bidentata root (18-24), Lepidium seed (10-15), Areca nut (5-

10), Luffa (16-22) and watermelon peel used for treating ascites due to 

cirrhosis (claimed), and increasing blood circulation, removing blood stasis, 

nourishing spleen and qi, accelerating liver cell regeneration, promoting 

urination and preventing liver fibrosis. The Chinese medicinal composition is 

safe and has quick and long lasting action with high curative rate and without 

toxic and side effects and adverse effects, and treats disease in short course. 
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          Pharmacological review of other Medicinal Plants having antidiabetic activity 

 

1. Nasreddine El Omari ,  Karima Sayah et al; (2019) evaluated the in vitro 

antioxidant activity and inhibitory potential of organic extracts from 

Aristolochia longa roots against key enzymes linked to hyperglycemia. 

Antioxidant activity was performed using 2,2 -diphenyl-1- picrylhydrazyl 

(DPPH) and 2,2-azino-bis-3-ethylbenzothiazoline-6-sulfonic acid (ABTS) 

radicals and ferric reducing/antioxidant power (FRAP) methods. Te-

Glucosidase and -Galactosidase inhibitory activities were investigated using 

an in vitro model 
37

.  

 

2. Guy Sedar Singor Njateng et al; (2018) To determine inhibitory activity of 

methanolic leaf extract of Piper umbellatum and Persea americana 

(traditionally used in Cameroon against diabetes) on -glucosidase, -

glucosidase, maltase-glucoamylase, aldose reductase and aldehyde reductase 

activities, enzymes involved in starch digestion or diabetic complications. To 

assess relative efficacy of these extracts, the determination of concentrations 

that were needed to inhibit 50% of enzyme activity was done, whereas, gas 

chromatography-mass spectrum was used to identify components from 

extracts that may be responsible for the activities 
38

. 
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AIM AND OBJECTIVE 

AIM: 

 To isolate and characterize an antidiabetic compound from the leaves of 

Merremia hederacea (Burm. f.) Hallier f.  

OBJECTIVE:  

 To perform soxhlet extraction on dried powdered of leaves using solvents such 

as petroleum ether, chloroform, ethyl acetate and ethanol. 

 To carry out preliminary phytochemical screening for the extracts using 

standard procedures. 

  To carry out in vitro antidiabetic activity for the extracts by alpha amylase and 

alpha glucosidase inhibition assay. 

 The carry out column chromatographic isolation for an active extract by using 

gradient elution technique. 

  The isolated compound will be characterized by using UV, IR, 
1
H-NMR and 

LC-MS. 

  Molecular docking study of the isolated compound will be performed on 

diabetic target protein using Auto dock software version 1.5.6. 

 Molecular docking study of the isolated compound will be performed on cancer 

target protein using Auto dock software version 1.5.6. 

 In vitro antidiabetic activity on alpha glucosidase inhibition assay will be 

carried out for the isolated compound. 

 In vitro anticancer activity will be carried out for isolated compound against 

liver cancer cell line (Hep G2). 

 Acute toxicity study will be carried out for an active extract by OECD 423 

guidelines. 

   In vivo antidiabetic activity of an active extract will be investigated in 

streptozotocin induced diabetic rats. 
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PLANT PROFILE 

      

                             Fig. No: 8   Merremia hederacea (burm. f.) hallier f. 

MERREMIA HEDERACEA (BURM. F.) HALLIER F. 

Synonym                   : Evolvulus hederaceus 

Family                       : Convulvulaceae 

Tamil Name              :  Elikkatutalai, 

Manipuri Name         :  Komalata. 

Malayalam                :  Kudicivalli.                                                

 

Distribution 

The genus Merremia (Convolvulaceae) comprises 70 species, which are primarily 

distributed throughout the warm and tropical regions of Asia and Africa. 

Morphology 

Merremia hederacea (Burm.f.) Hallier f., belongs to Convolvulaceae family, twinning 

or prostrate herb. The plant has slender stems; glabrous or pubescent, sometimes 

rooting at the nodes. The leaf-blades are ovate in outline, 1.5- 5cm long and 1.25-4cm 

wide. Petioles are 0.5-6cm long and sparsely tuberculate. Besides, the pedicels are 2-

4mm long. The sepals are obovate to spathulate, notched at the apex, and are sparsely 

pilose. The corolla is in white or yellow, 6-12mm long, glabrous outside, pilose at the 

base.  
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Ethno Medical uses 

Merremia hederacea can be used to treat colds, febrile disease, sunstroke, oliguria, 

tonsil inflammation, laryngitis as well as leucorrhoea. The seeds can be used to treat 

fevers, colds, sore throats, haematuria, conjunctivitis and boils. Leaves of M. 

hederacea can be used in the treatments of chapped hands and feet. No culinary and 

other uses have been reported for this herb. The genus Merremia reports to contains 

phenolics, flavonoids,, aliphatic pyrolidine amides, tropane containing alkaloid, the 

species possess to antioxidant, anti inflammatory, alpha amylase inhibitory activity.  

Traditionally, M. hederacea is widely used for the treatment of pharyngitis and 

furuncles. 
39
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MATERIALS AND METHODS 

Collection of Plant: 

The leaves of Merremia hederacea were collected from Tamil Nadu (forest of 

kalakatu) Tirunelveli District, India. Taxonomic identification was made from 

botanical survey of medicinal plants, Siddha Unit, Government of India, 

Palayamkottai authenticated by Chelladurai Botonist. Fresh plant leaves were shade 

dried at room temperature, ground into coarse powder and stored in airtight 

containers. 

Preparation of extracts: 

The dried powder of leaves was extracted sequentially by hot continuous percolation 

method by soxhlet apparatus using petroleum ether, chloroform, ethyl acetate and 

ethanol as solvent. The extracts were concentrated by using a rotary vacuum 

evaporator. 

 

Table no: 2 Percentage yield of leaf extracts of Merremia hederacea 

Extracts Nature of the extract Percentage yield 

Pet ether Yellowish brown 9.5% 

Chloroform Dark Green 12.6% 

Ethyl acetate Greenish Yellow 14.5% 

Ethanol Reddish yellow 18.65% 

 

Phytochemical Screening of active extracts from Merremia hederacea: 

         All the extracts were subjected to preliminary phytochemical screening for the 

detection of various plant constituents present. The pharmacological actions of crude 

drugs were determined by the nature of their constituents and the phytoconstituents 

are responsible for the desired therapeutic properties. 

                 To obtain these pharmacological effects, the plant materials itself or 

extracts in a suitable solvent or isolated active constituent may be used. The pet ether, 

chloroform, ethyl acetate and ethanolic extracts of Merremia hederacea was subjected 

to the following chemical tests used for the identification of various active 

constituents.
40, 41.
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TESTS FOR ALKALOIDS 

Dragendroff's Test 

The extract was treated with Dragondroff’s reagent and observed for the formation of 

yellow coloured precipitate indicates the presence of alkaloids. 

Wagner's Test 

The extract was treated with Wagner's reagent and observed for the formation of a 

reddish brown precipitate indicates the presence of the alkaloids. 

Mayer's Test 

The extract was treated with mayer’s reagent formation of white precipitate or creamy 

coloured precipitate indicates the presence of alkaloids. 

Hager's Test 

The extract was treated with Hager's reagent and observed for the formation of yellow 

precipitate indicates the presence of alkaloids. 

 

TEST FOR CARBOHYDRATES 

Molisch's Test 

To 2 ml of the extract 1 ml of alpha- naphthol solution was added and concentrated 

sulphuric acid was added through the sides of test tube. Purple or reddish violet colour 

at the junction of the two liquids revealed the presence of carbohydrates. 

Fehling's Test 

To 1ml of the extract equal quantities of Fehling's solution A and B were added while 

heating formation of a brick red precipitate that indicates the presence of 

carbohydrates. 

Benedict's test 

To 5ml of Benedict’s reagent 1ml of the extract solution was added and boiled for 2 

minutes and cooled. Formation of red precipitate shows the presence of 

carbohydrates. 

 

TESTS OF GLYCOSIDES 

Legal's Test 

The extract was dissolved in pyridine and sodium nitroprusside solution was added to 

make it an alkaline. The formation of pink red to red colour shows the presence of 

glycosides. 
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Baljet Test 

To 1 ml of the ethanolic extract was added with 1 ml sodium picrate solution and the 

yellow to orange colour reveals the presence of glycosides. 

Borntrager’s Test 

A few ml of dilute Hydrochloric acid was added to 1 ml of the extract solution. It was 

then boiled, filtered and the filtrate was extracted with chloroform. The chloroform 

layer was then treated with 1ml of ammonia. The formation of red colour shows the 

presence of anthraquinone glycosides. 

Keller Killiani Test 

The extract was dissolved in acetic acid containing traces of ferric chloride and it was 

then transferred to a test tube containing sulphuric acid. At the junction, formation of 

a reddish brown colour, which gradually became blue confirms the presence of 

glycosides. 

 

TESTS FOR PHYTOSTEROL 

Libermann Burchard Test 

3ml of extract was mixed with 3ml of acetic anhydride. It was heated and then cooled. 

Few drops of concentrated sulphuric acid was added. Appearance of blue colour 

shows the presence of phytosterol. 

Salkowski's Test 

Dissolve the extract in chloroform and equal volume of concentrate sulphuric acid 

was added. Formation of bluish red to cherry red colour in chloroform layer and green 

fluorescence in the acid layer represents the steroid components present in the extract. 

 

TEST FOR FLAVONOIDS 

Shinoda test 

The extract was treated with 5ml of 95% ethanol. Add few drops of concentrated 

hydrochloric acid and 0.5g of magnesium turnings. Pink colour was observed which 

shows the presence of flavonoids. 
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TEST FOR TANNINS AND PHENOLIC COMPOUNDS 

Ferric chloride test  

1 ml of the extract was added with ferric chloride and observed for the formation of a 

dark blue or greenish black colour indicates the presence of Tannins and Phenolic 

compounds. 

Gelatin Test 

The extract was treated with 1%gelatin containing 10%NaCl and observed for the 

precipitation which indicates the presence of Tannins and Phenolic compounds. 

 

TESTS FOR PROTEINS AND AMINO ACIDS 

Biuret Test 

1ml of the extract was treated with 1ml of 40% sodium hydroxide solution followed 

by 2 drops of 1% copper sulphate solution. Formation of a violet colour shows the 

presence of proteins. 

Xanthoproteic Test 

1ml of the extract was treated with 1ml of concentrated nitric acid. A white precipitate 

was formed, it was boiled and cooled. Then 20% of sodium hydroxide or ammonia 

was added orange colour was formed indicates the presence of aromatic amino acids. 

Lead Acetate Test 

The extract was treated with 1ml of lead acetate. Formation of a white precipitate 

indicates the presence of proteins. 

 

TEST FOR SAPONINS 

About 1 ml of ethanol extract was diluted separately with distilled water to 20 ml and 

shaken in a graduated cylinder for 15 minutes. A1% 1 cm layer of foam indicates the 

presence of saponins. 

 

TEST FOR TRITERPENOIDS 

Two or three granules of tin metal in 1ml thionyl chloride solution were dissolved and 

1ml of the extract was added into a test tube. The formation of pink colour indicates 

the presence of Triterpenoids. 
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TEST FOR FIXED OILS 

Spot Test 

A small quantity of the extract was pressed between two filter papers. Oil stains on 

the filter paper indicates the presence of fixed oils. 

 

 Table no 3.  Preliminary Phytochemical analysis on leaf extracts of  

Merremia hederacea 

NOTE: + POSITIVE; - NEGATIVE  

RESULT: 

From the preliminary phytochemical screening, it was observed that Pet. ether extract 

shows the presence of phytosterol, triterpenoids, proteins, amino acids and fixed oils. 

Chloroform extract shows the presence of alkaloids, carbohydrates, phytosterol, 

flavonoids, proteins and amino acids. Ethyl acetate extract shows the presence of 

glycosides, flavonoids and terpenoids. Ethanolic extract shows the presence of 

glycosides, flavonoids, tannins and Phenolic compounds. 

 

In vitro antidiabetic activity: 

All the four extracts were subjected to in vitro antidiabetic activity by alpha amylase 

inhibition assay and alpha glucosidase inhibition assay. 

TEST PET 

ETHER 

CHLOROFORM ETHYL 

ACETATE 

ETHANOL 

ALKALOIDS - + - + 

CARBOHYDRATES - + - - 

GLYCOSIDES - - + + 

PHYTOSTEROLS + + - - 

FLAVONOIDS - + + + 

TANNINS & PHENOLIC 

COMPOUNDS 

- - - + 

PREOTEINS & AMINO 

ACIDS 

+ + - - 

SAPONINS - - - + 

TERPENOIDS + - + - 

FIXED OILS + - - - 
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IN VITRO ANTIDIABETIC ACTIVITY 

 

PROCEDURE: 

Alpha - amylase inhibitory activity: 

This study was performed by a modified starch iodine protocol. In short, plant 

extract and standard concentration (10, 20, 40, 80, 160, 320µg/mL.) was taken in pre 

labelled test tubes. A volume of 20 mL of α-amylase was added to each test tube and 

incubated for 10 min at 37 °C. After the incubation 200 μL of 1% starch solution was 

added to each test tube and the mixture was re-incubated for 1 h at 37 °C. Then 200 

μL of 1% iodine solution was added to each test tube and after that, 5 mL distilled 

water was added. Absorbance of the mixture was taken at 565 nm. Blank were 

undertaken under the same conditions. IC50 value was calculated by using regression 

analysis 
42, 43

 

 

Where, Ac is the absorbance of the control and; As is the absorbance of the sample. 

Alpha - Glucosidase Inhibition assay: 

The effect of the plant extracts on α-glucosidase activity was determined using 

α-glucosidase enzyme. The substrate solution p-nitro phenyl glucopyranoside (pNPG) 

was prepared in 20mM phosphate buffer, and pH 6.9. 100 µL of α-glucosidase was 

pre-incubated with 2.5ml of the different concentrations of the extracts for 10min. 

Then 50 µL of 3.0mM (pNPG) as a substrate dissolved in 20mM phosphate buffer 

(pH 6.9) was then added to start the reaction. The reaction mixture was incubated at 

37 ˚C for 20min and stopped by adding 0.5mL of Na2CO3 (0.1M). The yellow-

coloured reaction mixture, 4-nitrophenol, released from pNPG was measured at 

405nm using UV - VIS spectrophotometer 
44

.Acarbose was used as a positive control 

and the inhibitory activity of α-glucosidase was calculated using the following 

formula,  

% Inhibition = [(Abs Control - Abs Sample) / Abs Control] x 100. 
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Table no: 4 Effect of extracts of Merremia hederacea on Alpha-amylase 

 

Concentration 

in μg level 

 

Pet ether 

extract 

 

Chloroform 

extract 

 

Ethyl 

acetate 

extract 

 

Ethanol 

extract 

 

Acarbose 

(standard) 

10 6.55 9.25 10.47 13.68 47.86 

20 10.93 35.23 40.11 57.14 69.75 

40 19.21 40.21 45.62 59.47 76.31 

80 26.08 45.18 52.62 76.95 90.44 

160 29.32 50.23 60.41 89.49 90.62 

320 38.23 55.54 65.44 91.44 95.44 

 

 

Fig. No: 9 α- amylase inhibition assay for the extracts of Merremia hederacea 

 

0

20

40

60

80

100

120

0 50 100 150 200 250 300 350

%
 I

n
h

ib
it

io
n

 

Concentration (µg/ml) 

Alpha amylase assay 

Pet ether

Chloroform

Ethyl
acetate

Ethanol

Acarbose



                                                                                                        IN VITRO STUDY 

 

Department Of Pharmaceutical Chemistry, MMC. Page 31 
 

Table no : 5 Effect of extracts of Merremia hederacea on alpha glucosidase  

 

 

Concentration 

in μg level 

 

Pet ether 

extract 

 

Chloroform 

extract 

 

Ethyl 

acetate 

extract 

 

Ethanol 

extract 

 

Acarbose 

(standard) 

10 3.15 4.33 3.15 19.24 47.86 

20 6.72 9.94 8.93 22.12 69.75 

40 23.86 25.21 19.81 40.27 76.31 

80 31.82 34.01 27.94 55.27 90.44 

160 72.96 71.40 59.38 78.58 90.62 

320 62.24 70.33 69.82 85.50 95.45 

 

 

 

 
     

Fig. No: 10. α-glucosidase inhibition assay for the extracts of Merremia hederacea 
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RESULTS: 

IN VITRO ANTIDIABETIC ACTIVITY 

Alpha amylase assay 

As illustrated in table 4, alpha amylase assay was carried out for the extracts of 

Merremia hederacea. It was found that ethanol extract shows good antidiabetic 

activity compared to other extracts. At highest concentration 320µg, ethanol extract 

shows greater percentage inhibition of 91.44%. The standard acarbose also shows 

good alpha amylase inhibition with a percentage inhibition of 95.44%  

Fig 9 shows the percentage inhibition of all the extracts and standard acarbose against 

alpha amylase.    

Alpha glucosidase assay 

As illustrated in the table 5, alpha glucosidase assay was carried out for the extracts of 

Merremia hederacea. It was found that, ethanol extract shows greater percentage 

inhibition of 85.50% at 320µg. The standard agarbose also shows greater alpha 

glucosidase inhibition with a percentage inhibition of 95.45. Fig 10, shows the 

percentage inhibition of all the extracts and standard against alpha glucosidase.   

Discussion  

The use of herbal drugs as complementary approaches in existing medications for the 

treatment of diabetes and its complications is growing worldwide and many plants in 

different countries are known to have antidiabetic effects.
45

 The ancient Indian 

literature reports more than 800 plants with antidiabetic properties while 

ethnopharmacological surveys indicate that more than 1200 plants can be used for 

hypoglycemic activity 
46

. Mainly two carbohydrate hydrolyzing enzymes (α-amylase 

and α-glucosidase) are responsible for postprandial hyperglycemia. α-amylase begins 

the process of carbohydrate digestion by hydrolysis of 1, 4-glycosidic linkages of 

polysaccharides (starch, glycogen) to disaccharides and α-glucosidase catalyzes the 

disaccharides to monosaccharides, which leads to postprandial hyperglycemia. Hence, 

inhibitors of α-amylase and α-glucosidase are useful in the control of hyperglycemia 

as they delay carbohydrate digestion, which consequently reduce the postprandial 

plasma glucose level 
47, 48

.  
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Many bioactive compounds from different plants have been reported to have 

hypoglycemic effect, in that mostly phenolics, resin glycosides and flavonoids have a 

positive correlation as antidiabetic agents 
49

. The presence of flavonoids, phenolic 

compounds in extracts of Merrimia hederaceae may act against diabetes mellitus 

either through their capacity to avoid glucose absorption or to improve glucose 

tolerance by competitive inhibition of sodium-dependent glucose transporter-1 

Another possible mechanism followed by flavonoid compounds (luteolin, kaempferol, 

chrysin, and galangin) to control blood glucose levels is the inhibition of α-amylase 

and α-glucosidase activity in the intestine 
50,51

.               
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ISOLATION BY COLUMN CHROMATOGRAPHY 

            The ethanol extract is active and shows good in vitro anti diabetic activity 

compared to other extracts. Hence the bioactive guided isolation was performed and 

the ethanol extract of Merremia hederacea (ETMH) was subjected for column 

chromatographic isolation by gradient elution technique. 

Packing of column: 

 Wet packing technique was used for the isolation. Initially cotton plug is kept 

at the bottom of the column and eluting solvent (Hexane) was added to 3/4
th

 of 

the column. 

 Pre heated Silica gel (60-120 mesh size) is mixed with eluting solvent 

(Hexane) to make it as slurry and added to the column and the silica gel was 

allowed to settle down to from a uniform packing. 

 Then the stop-cock of the column was opened and the excess of solvent over 

the column head was allowed to run. 

Packing of active extract:  

          After the silica gel packing, the ethanol extract (5g) was mixed with the desired 

solvent then silica gel was added slowly with stirring and heated to get a free flowing 

powder. The powdered sample was then applied carefully on the top of the prepared 

column. 

Elution Process:   

 The active extract was eluted by gradient elution technique by 

solvent/solvent system using various solvent systems such as Hexane, 

Hexane: chloroform, chloroform, chloroform: ethyl acetate, ethyl acetate, 

Ethyl acetate: methanol to separate the eluate. When the mixture of solvent 

system used, the ratio of mixtures are prepared as 100%, 90:10, 80:20, 

70:30, 60:40, 50:50, 40:60, 30:70, 20:80 and 10:90. 

 Elutes were collected and marked from fractions 1-29. Each 50ml fractions 

were collected. 

 All the fractions were spotted successfully on TLC plate and the fractions 

having same Rf value are pooled together and evaporated to dryness. 
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Table no: 6     Number of fractions collected and solvent systems 

 

S. NO. 

 

FRACTIONS 

 

SOLVENT SYSTEM 

1 F-1 Hexane 

2 F-2 to F-8 

 

Hexane :  chloroform 

3 F-9 Chloroform 

4 

 

F-10 to F-18 Chloroform : ethyl acetate 

5 F-19 Ethyl acetate 

6 F-20 to F-24 Ethyl acetate : methanol 

7 

 

F-25 to F 29 Ethyl acetate : methanol : glacial acetic 

acid 

 

 

The yellow colour band was eluted in fractions 20-24 in the solvent system ethyl 

acetate: methanol (80:20). The fractions show similar Rf value in thin layer 

chromatography and contains 2 spots and were mixed together and evaporated. The 

reddish brown band was eluted in fraction 25 -29 in the solvent system ethyl acetate: 

methanol: glacial acetic acid (60.30:10). The fractions 25 -29 were tested in TLC with 

various solvent systems. The fractions 25- 29 show similar Rf values and shows single 

spot and were mixed together and evaporated to yield a yellow amorphous compound. 
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Table no: 7 Thin layer chromatography of isolated compound 

S.no Fractions Solvent systems No of spot Rf value 

1 20 – 24 Chloroform: methanol   (90: 10) 

Chloroform: methanol   (80: 20) 

Ethyl acetate: methanol (90: 10) 

Ethyl acetate: methanol  (80: 20) 

2 

2 

2 

2 

0.6, 0.8 

0.7,0.9 

0.8,0.9 

0.9 

 

2 25 – 29 Chloroform: methanol   (90: 10) 

Chloroform: methanol   (80: 20) 

Ethyl acetate: methanol (90: 10) 

Ethyl acetate: methanol  (80: 20) 

1 

1 

1 

1 

0.8 

0.8 

0.9 

0.9 

 

 The compound is a yellow amorphous powder. FeCl test was performed and shows 

positive (dark green) and it is characterized by UV, IR, 
1
H-NMR & LCMS.  

 Characterization of an isolated compound (10mg) 

  Ultraviolet spectroscopy was performed in (MeOH) λmax  253.0, 278.0 nm. 

  Infra red spectroscopy (KBr Pellet) 3425.33 cm
-1  

Aromatic O-H Stretching, 1643.23 

cm
-1   

C =O (Chelated carbonyl group), 1396.36 cm
-1   

CH3 , 2877 cm
-1 

CH – Aliphatic, 

1728 cm
-1  

Ketones (Carbonyl group) 

  HPLC + PDA+ MS: HPLC + PDA+ MS with a molecular ion peak, [M]
+ 

at 325.10 

[M+ H]
+ 

and other fragments at 269.95, 369.05. From, the previous literature survey, 

the molecular ion peak and fragments matched with a related prenylated derivatives of 

chalcone. 

1
H NMR (Bruker DMSO 500 MHz): δ 1.642 (3H, s), δ 1.753 (3H, s ),  δ 3.25 (2H, d),  

δ 5.201 (1H, t),   δ 6.501 (1H, d), δ6.850 (2H, d),   δ7.254 (1H, d), δ 7.710 (1H, d), δ 

7.772 (2H,d), δ 8.131, δ 10.12(1H, s), (s,  δ2.50 (DMSO solvent peak.). 
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Discussion 

  ULTRA VIOLET SPECTROSCOPY 

  Ultraviolet spectroscopy was performed in (MeOH) λmax  253.0 nm,, 278.0 nm. 

   1
H NMR (Bruker DMSO 500 MHz) 

  The 
1
H NMR exhibited a set of 1.642 and 1.753 (3H  signals for a prenyl substituent 

at 3.250 (2H, d), δ 3.252 (2H, d), δ 5.201 (1H, t), δ 6.850 (2H,d) Signals observed at 

7.254, 7.710 and 7.772 (1H each) are characteristic for trans-olefinic protons. A set of 

doublet at δ6.850 and a doublet at δ7.772 (1H each, d) was attributable to ortho 

coupled aromatic protons and H-  H- β in chalcone skeleton 
52

 

  HPLC + PDA+ MS  

  From the observations in correspondent in HPLC + PDA+ MS the m/z value325.10 

[M+ H]
+
  with the retention time 4.297 and the other fragments at 269.95, 369.05. The 

isolated compound was found to be 2′, 4, 4′-Trihydroxy-3′-(3-methyl-2-butenyl)-

chalcone with the molecular formula C20H20O4.
53

 

  INFRA RED SPECTROSCOPY (KBr Pellet) 

3425.33 cm
-1  

 shows the presence of aromatic O-H Stretching, 1643.23 cm
-1   

C =O 

shows the presence of chelated carbonyl group), 1398.36 cm
-1 

characteristic of
  
CH3 

group , 2877 cm
-1 

CH – Aliphatic, 1728 cm
-1  

shows the presence of ketones (Carbonyl 

group). 
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Fig.no 11: UV Spectrum of isolated compound from ethanol extract of Merremia 

hederaceae (ETMH) 
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Fig.no 12: IR Spectrum of isolated compound from ethanol extract of Merremia 

hederacea ( ETMH ) 
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Fig.no: 13 LCMS/MS Chromatogram of isolated compound from ethanol extract 

of Merremia hederaceae (ETMH) 
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               Fig.no: 14 LC-MS/MS of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl)chalcone. 
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             Fig.no: 15   
1
H-NMR of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl) chalcone. 

 

   

      

 

 

    Fig no: 16. Structure of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl)chalcone 
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MOLECULAR DOCKING STUDY OF 2', 4, 4'-TRIHYDROXY- 

3'–(METHYL-2-BUTENYL) CHALCONE AGAINST DIABETIC 

TARGET PROTEIN 

 

Molecular docking is generally used to detect the protein-ligand orientation and 

interaction. Auto Dock Tools package version 1.5.6 was utilized to create the docking 

input files. The grid region was surrounded by the active site for binding. So, grid 

region was selected on the basis of amino acid residues representing the binding site 

of Miglitol as the standard drug obtained from PDB with ID- 3L4W and considered as 

the best active region for the favourable interaction. The grid box was set at 126 × 126 

× 126 A˚ for x, y and z axis and covered the active site of the target protein. The 

Lamarckian Genetic Algorithm (LGA), a local search algorithm was utilized for 

ligands conformers searching. During the docking process, a maximum of 10 

conformers were considered for the compound. After completion of the conformer the 

lowest binding energy was chosen. The conformational similarity by visualizing the 

binding site and its energy (Kcal/mol) and the docked amino acid residues forming 

hydrogen bonds and other parameters like intermolecular energy (Kcal/mol) and 

inhibition constant (μM) were analysed by Auto Dock tool. Ten best poses were 

generated for the ligand and scored using Auto Dock -11.28 kcal
-1

 scoring functions. 

Based on the docked energy the ligand was selected for anti diabetic activity. The 

ligand interacting residues with the target protein were analyzed using Auto Dock 

tools, Molegro Molecular viewer.
54
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Fig.no 17.  Number of amino acid interaction 

 

 

 

Fig.No:18 protein ligand interaction 

 

AUTO DOCK and ADT 

Short Tutorial: 

Overview: 

Working with AutoDock4 includes 3 steps: 

1. Preparation of receptor & ligand files. 

2. Calculation of affinity maps by using a 3D grid around the receptor & ligand. 
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3. Defining the docking parameters and running the docking simulation. 

The preparation step starts with pdb files of receptor (protein.pdb) and ligand 

(ligand.pdb), which are added hydrogens and then saved as protein.pdb & ligand.pdb. 

The calculation of affinity maps in the "Grid" section requires the above pdb files to 

be assigned charges & atom types, and also that the nonpolar hydrogens are merged. 

This is done automatically by ADT, and the resulting files need to be saved as 

protein.pdbqt&ligand.pdbqt, which is the only format AutoGrid&AutoDock can work 

with. Calculation of affinity maps is done by AutoGrid and then docking can be done 

by AutoDock. The newest docking algorithm is LGA (Lamarckian Genetic 

Algorithm). 

 

For running ADT, you should be following next steps: 

1. Install MGL tools. 

2. Download autogrid4.exe, autodock4.exe and AD4.1_bound.dat files. 

3. Install Molegro Molecular Viewer. 

4. Install ChemDraw including 3D Pro. 

After having finished installation of above tools, you can run ADT. Here, I 

recommend you to follow my current protocol for running it: 

1- Create a work folder for your job and tag it based on your favorite name. (e.g. 

project) 

2- running ADT in start menu in windows: 

after running you should set its directory: following these steps: 

a) open ADT> File> Preferences>set>Startup Directory (in this section you should 

put on 

yourworkfolder path and set it). for example: “C:\Users\project 

3- prepare ligand and protein in ".pdb" format. Notice, you must have labeled them by 

"Ligand" and "Protein" keywords. Protein can be preprocessed by Molegrow 

Molecular 

Viewer & Ligand can be initially prepared using in ChemBioDraw and can be saved 

as pdb. 

After having finished these steps you can open ADT: Well! you should do the below 

ways: 

1- open ADT: 

File > Read Molecule> Select Protein File (“.pdb” file) 
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Then: 

Edit >Hydrogens>Add>>>>>> Polar Only >OK 

Molecular Docking 

Department of Pharmaceutical Chemistry,MMC. Page 64 

Edit >Hydrogens> Merge Non-Polar > Continue (in this step if you see any warning 

please 

click on "continue") 

then: 

Edit > Charges > Compute Gasteiger> Ok 

Edit >Misc> Repair Missing Atoms> Ok/Select all > Dismiss 

File > Save > Write PDB>>Sort Nodes (Check) > OK > (Overwrite) YES 

Well! in the next step you should try prepare the ligand: 

Ligand > Input > Open> Select Ligand File (“.pdb” file) > OK 

Now repeat above steps and then: (in this section you must add charge to your ligand. 

So, 

click on 

Edit menu and: 

Edit> Charges> Add Kollman charges 

Ligand > Output > Save as PDBQT 

****************************** 

Now you should be executing AutoGrid4: 

For AutoGrid following the below steps: (preparing gpf file) 

1-Grid >Macromole> Choose> Click (Protein) > Select Molecule > OK > save Save 

as 

PDBQT 

2-Grid> Set Map types >Choose Ligand> Click (Ligand) > Select Ligand 

3-Grid >GridBox> Set the BOX> File > Close Saving Current 

4-Grid > Output > Save GPF>grid.gpf> save 

*************************************************************** 

After having finished above steps following the below ways: 

For Autodock following the below steps: (preparing dpf file) 

1)Docking> Macromolecule > Set Rigid filename> Select „Protein.pdbqt‟  > Open 

2-Docking > Ligand > Choose> Click „Ligand‟  > Select Ligand> Accept 

3-Docking > Search Parameters > Genetic Algorithm> Accept 
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4-Docking > Output > Lamarckian GA> Save file as „dock.dpf‟  

*********************************************************** 

Now copy the autogrid4.exe, autodock4.exe and AD4.1_bound.dat files into the 

destination 

folder (working folder) and check whether 2 pdbqt files and grid.gpf and dock.dpf 

files are 

there. 

After having finished above steps following the below ways: 

1-open cmd (command prompt). Windows +R and type cmd enter. 

2-in command prompt go the destination folder by cd commands. 

3-run the following commands 

4- autogrid4.exe -p grid.gpf -l grid.glg (wait for the response) 

5- autodock4.exe -p dock.dpf -l dock.dlg (wait for the response) 

Now the dock.dlg file is your docking result. 

*********************************************************** 

1-Analyze > Docking > Open> Select „dock.dlg‟  > Open >Assign Ligand New 

Name > OK 

2-Analyze > Macromolecule > Choose> Click „Protein‟  > Select Macromolecule 

3- Analyze> Conformations> Play, Ranked By Energy or Play > Click on the „&‟  

Button 

4-Set Play Options >Check „Build H-Bonds‟ > View the hydrogen bonds formed > 

Check 

„Show Info‟ > View the Interaction Energy > Build Current Write Complex> Save as 

„Result.pdb‟  save.... 

For better ligand interactions you can open the result.pdb in Molegro Molecular 

Viewer and 

View it and save the ligand interaction image. 
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Results: 

From the previous literature review of the docking results of a standard ligand 

(Miglitol) had a binding energy of -8.04 kcal/mol. The hydrogen bond forming amino 

acid residues of the target protein was found to be His 626 and Asp 232.Excluding 

hydrogen interaction, the ligand was also formed nine electrostatic interaction with 

the amino acids. 

 

The ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) was predicted to 

have better binding energy of –11.28 kcal/mol as compared to standard drug. It forms 

hydrogen bond interactions with amino acid residues of the target protein, Lys534, 

Ala 537, Lys 776, Arg 520, Gly 533. 

Discussion 

In this docking study, we present an approach to control blood glucose levels in 

individuals with type 2 diabetes by targeting maltase- glucoamylase and intestinal 

glucosidases using a ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) 

isolated from Merremia hederacea. One of the intestinal glucosidases targeted the N-

terminal catalytic domain of maltase-glucoamylase (ntMGAM) which is responsible 

for the hydrolysis of terminal starch products into glucose. Hence to slow down the 

glucose level and targeted the ntMGAM. Previously acarbose and miglitol were found 

to be potent inhibitors alpha glucosidase having poly hydroxy groups in their structure 

. Hence novel ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) which has 

three hydroxyl groups and is chalcone based isolated from Merremia hederacea was 

docked for the binding sites of alpha glucosidase. The ligand (2',4,4'-trihydroxy-3'–

(methyl-2-butenyl) chalcone) was predicted to have better binding energy of –11.28 

kcal/mol as compared to standard drug. It forms hydrogen bond interactions with 

amino acid residues of the target protein, Lys534, Ala 537, Lys 776, Arg 520, Gly 533 

(fig 17, 18). Hence the isolated compound has better binding energy into alpha 

glucosidase than the standard drug miglitol.
55
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MOLECULAR DOCKING STUDY OF 2',4,4'-TRIHYDROXY-3'–

(METHYL-2-BUTENYL) CHALCONE AGAINST CANCER 

TARGETED PROTEIN 

 

Molecular docking is generally used to detect the protein-ligand orientation and 

interaction. Auto Dock Tools package version 1.5.6 was utilized to create the docking 

input files. The grid region was surrounded by the active site for binding. So, grid 

region was selected on the basis of amino acid residues representing the binding site 

of 5-Fluoro uracil as the standard drug obtained from PDB with ID- 1FP2 and 

considered as the best active region for the favourable interaction. The grid box was 

set at 126 × 126 × 126 A˚ for x, y and z axis and covered the active site of the target 

protein. The Lamarckian Genetic Algorithm (LGA), a local search algorithm was 

utilized for ligands conformers searching. During the docking process, a maximum of 

10 conformers were considered for the compound. After completion of the conformer 

the lowest binding energy was chosen. The conformational similarity by visualizing 

the binding site and its energy (Kcal/mol) and the docked amino acid residues 

forming hydrogen bonds and other parameters like intermolecular energy (Kcal/mol) 

and inhibition constant (μM) were analysed by Auto Dock tool. Ten best poses were 

generated for the ligand and scored using Auto Dock 1.5.6 scoring functions. Based 

on the docked energy the ligand was selected for anti cancer activity. The ligand 

interacting residues with the target protein were analyzed using Auto Dock tools, 

Molegro Molecular viewer. 

 

Results & Discusion 

From the previous literature review of the docking results of a standard ligand (5-

Fluoro uracil) had a binding energy of -4.67 kcal/mol. The hydrogen bond forming 

amino acid residues of the target protein was found to be Leu 103 and Val 37. 

Excluding hydrogen interaction, the ligand was also formed nine electrostatic 

interaction with the amino acids. 

 

The ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) was predicted to 

have better binding energy of – 9.56 kcal/mol as compared to standard drug. It forms 
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hydrogen bond interactions with amino acid residues of the target protein Asn 165, 

Asp 239, Asp 219, Gly 196 (fig 19 & 20). 

Chalcone O-methyltransferase (ChOMT) and isoflavone O-methyltransferase (IOMT) 

are potent targets for antitumour activity and are SAM dependent methyltransferases 

whose crystal structures with flavonoids have been determined. The crystal structure 

of ChOMT in complex with the product S-adenosyl-l-homocysteine and the substrate 

isoliquiritigenin (4,2',4'-trihydroxychalcone) as well as the crystal structure of IOMT 

in complex with the products S-adenosyl-l-homocysteine and isoformononetin (4'-

hydroxy-7- methoxyisoflavone) have been determined.
56

 

 

Fig.no 19.Number of amino acid interaction 

 

 

Fig.no 20.Protein ligand interaction 
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IN VITRO ANTIDIABETIC ACTIVITY  OF 2′, 4, 4′ -

TRIHYDROXY-3′-(3-METHYL-2-BUTENYL) CHALCONE 

AGAINST ALPHA GLUICOSIDASE 

 

PROCEDURE: 

Alpha - Glucosidase Inhibition assay: 

The effect of the plant extracts on α-glucosidase activity was determined using 

α-glucosidase enzyme. The substrate solution p-nitro phenyl glucopyranoside (pNPG) 

was prepared in 20mM phosphate buffer, and pH 6.9. 100 µL of α-glucosidase was 

pre-incubated with 2.5ml of the different concentrations of the extracts for 10min. 

Then 50 µL of 3.0mM (pNPG) as a substrate dissolved in 20mM phosphate buffer 

(pH 6.9) was then added to start the reaction. The reaction mixture was incubated at 

37 ˚C for 20min and stopped by adding 0.5mL of Na2CO3 (0.1M). The yellow-

coloured reaction mixture, 4-nitrophenol, released from pNPG was measured at 

405nm using UV - VIS spectrophotometer 
57

 voglibose was used as a positive control 

and the inhibitory activity of α-glucosidase was calculated using the following 

formula,  

% Inhibition = [(Abs Control - Abs Sample) / Abs Control] x 100. 

 

Table no: 8. Effect of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl)chalcone 

against alpha glucosidase 

 

Concentration 

in μg level 

 

Standard (voglibose) Percentage inhibition 

10 11.28809 4.466759 

20 35.07618 30.87262 

40 66.23961 42.98427 

80 81.6482 65.23876 

160 92.20914 75.23854 

320 94.49446 80.57829 
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Fig: no. 21. Alpha glucosidase inhibition assay of 2′, 4, 4′ -Trihydroxy-3′-(3-

methyl-2- butenyl) chalcone 

 

Discussion: 

Alpha glucosidase inhibition assay of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- 

butenyl)chalcone  

As illustrated in table 8 & fig 21, the isolated compound, was evaluated against alpha 

glucosidase inhibition assay. It was found that 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- 

butenyl) chalcone showed good anti diabetic activity with a percentage inhibition of 

80.57% at 320µg compared to the standard voglibose with a percentage inhibition of 

94.49 at 320 µg.  

Discussion  

2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl) chalcone is a class of flavonoids, 

possess good antidiabetic activity. Chalcones are secondary metabolites of terrestrial 

plants and precursors of the flavonoids biosynthesis, have been used for a long time in 

traditional medicine due to their wide-range of biological activities, from which the 

anti-diabetic activity stands out. Chalcones are able to exert these properties by acting 

in different therapeutic targets: 
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dipeptidyl peptidase 4 (DPP-4); glucose transporter type 4 (GLUT4), sodium glucose 

cotransporter 2 (SGLT2), α-amylase, α-glucosidase, aldose reductase (ALR), protein 

tyrosine phosphatase 1B (PTP1B), peroxisome proliferator-activated receptor-gamma 

(PPARγ) and adenosine monophosphate (AMP)-activated protein kinase (AMPK). 

Chalcones are, undoubtedly, promising anti-diabetic agents, and some crucial 

structural features have already been established. From the structure-activity 

relationships analysis, it can generally be stated that the presence of hydroxyl, prenyl 

and geranyl groups in their skeleton improves their activity for the evaluated 

antidiabetic targets 
58
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IN VITRO ANTICANCER ACTIVITY OF 2′, 4, 4′ -TRIHYDROXY-

3′-(3-METHYL-2- BUTENYL)CHALCONE AGAINST LIVER 

CANCER CELLS (Hep G2) 

 

Anticancer Activity studies using MTT 

Introduction 

The in vitro determinations of toxic effects of unknown compounds have been 

performed by counting viable cells after staining with a vital dye. Alternative methods 

used are measurement of radioisotope incorporation as a measure of DNA synthesis, 

counting by automated counters and others which rely on dyes and cellular activity. 

The MTT system is a means of measuring the activity of living cells via 

mitochondrial dehydrogenases. The MTT method is simple, accurate and yields 

reproducible results. The key component is (3-[4, 5-dimethylthiazol-2-yl]-2, 5-

diphenyl tetrazolium bromide) or MTT, is a water soluble tetrazolium salt yielding a 

yellowish solution when prepared in media or salt solutions lacking phenol red. 

Dissolved MTT is converted to an insoluble purple formazan by cleavage of the 

tetrazolium ring by mitochondrial dehydrogenase enzymes of viable cells. This water 

insoluble formazan can be solubilized using DMSO, acidified isopropanol or other 

solvents (Pure propanol or ethanol). The resulting purple solution is 

spectrophotometrically measured. An increase or decrease in cell number results in a 

concomitant change in the amount of formazan formed, indicating the degree of 

cytotoxicity caused by the test material. 
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Materials & Methods 

1. MTT reagent (the solution is filtered through a 0.2 μm filter and stored at 2–8 °C 

for 

frequent use or frozen for extended periods) 

2. DMSO 

3. CO2 incubator 

4. Micro Plate reader 

5. Inverted microscope 

6. Refrigerated centrifuge 

Preparation of test solutions 

For Anticancer studies, serial two fold dilutions (200-1000μg/ml) were 

prepared from this for carrying out Anticancer studies. 

Cell lines and culture medium 

Liver cancer (HepG2) cell lines were procured from NCCS, stock cells was 

cultured in medium supplemented with 10% inactivated Fetal Bovine Serum (FBS), 

penicillin (100 IU/ml), streptomycin (100 μg/ml) in an humidified atmosphere of 5% 

CO2 at 37
o
C until confluent. The cell was dissociated with TPVG solution (0.2 % 

trypsin, 0.02 % EDTA, 0.05 % glucose in PBS). The viability of the cells are checked 

and centrifuged. Further 50,000 cells / well was seeded in a 96 well plate and 

incubated for 24 hrs at 37
o
C, 5% CO2 incubator. 

59
 

Source of reagents: DMEM, FBS, Pen strip, Trypsin procured from Himedia. 

Procedure 

The monolayer cell culture was trypsinized and the cell count was adjusted to 

1.0 x 10
5
 cells/ml using respective media containing 10% FBS. To each well of the 96 

well microtiter plate, 100μl of the diluted cell suspension (50,000cells/well) was 

added. After 24 h, when a partial monolayer was formed, the supernatant was flicked 

off, washed the monolayer once with medium and 100μl of different test 

concentrations of test drugs were added on to the partial monolayer in microtiter 

plates. The plates were then incubated at 37
o
C for 48hrs in 5% CO2 atmosphere. After 

incubation the test solutions in the wells were discarded and 100μl of MTT (5 mg/10 

ml of MTT in PBS) was added to each well. The plates were incubated for 4h at 37
o
C 

in 5% CO2 atmosphere.  The supernatant was removed and 100μl of DMSO was 

added and the plates were gently shaken to solubilize the formed formazan. The 

absorbance was measured using a microplate reader at a wavelength of 570 nm. The 
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percentage growth inhibition was calculated using the following formula and 

concentration of test drug needed to inhibit cell growth by 50% (IC50) values is 

generated from the dose-response curves for each cell line. 
60

 

IC50 Value: 

The half maximal inhibitory concentration (IC50) is a measure of the 

effectiveness of a compound in inhibiting biological or biochemical function. This 

quantitative measure indicates how much of a particular drug or other substance 

(inhibitor) is needed to inhibit a given biological process (or component of a process, 

i.e. an enzyme, cell, cell receptor or microorganism) by half. 

The IC50 of a drug can be determined by constructing a dose-response curve 

and examining the effect of different concentrations of antagonist on reversing agonist 

activity. IC50 values can be calculated for a given antagonist by determining the 

concentration needed to inhibit half of the maximum biological response of the 

agonist. IC50 values for cytotoxicity tests were derived from a nonlinear regression 

analysis (curve fit) based on sigmoid dose response curve. 

 

The direct Microscopic Observations of Drug Treated Images of Cell lines by 

Inverted Biological Microscope was enclosed with the report. 

Table: no 9 Anticancer activity of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- 

butenyl)    chalcone against liver cancer cell (Hep G2) 

 

 

 

 

 

 

 

 

 

 

 

   

Concentration 

Unit: µG 

 

Isolated 

compound 

Standard ( 5-Fluoro 

Uracil) 

3.12 63.52 48.73 

6.25 54.81 40.04 

12.5 52.78 30.58 

25.00 40.96 20.81 

50.00 29.88 14.52 

100 18.75 5.29 

IC50 value 10.57 2.73 
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                     3.12µg                                           6.25µg 

 

             

                      12.5 µg                                       25µg 

                        

   

          50 µg                                       100 µg 

 

                                       

                                                    control 

Fig: no 22.  Percentage cell growth of Liver cancer cells on treatment with    2′, 

4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl)chalcone at various concentrations. 
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 3.12µg                                                  6.25 µg 

 

            

 12.5µg                                                   25 µg 

 

 

                     

 50µg 100 µg 

 

Fig: no 23.  Percentage cell growth of Liver cancer cells on treatment with  

5 - Furo Uracil at various concentrations.   
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In vitro Anticancer Activity of 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl)   

chalcone 

MTT Assay 

As illustrated in table 9, in vitro anticancer activity was carried out for the isolated 

compound 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl)   chalcone  against liver 

cancer cell line (HepG2). The percentage viability at 100µg of the isolated 

compoundwas found to be 18.75 and an IC50 value of 10.57. The 2′, 4, 4′ -

Trihydroxy-3′-(3-methyl-2- butenyl) chalcone shows good anticancer activity 

against liver cancer cell line. The standard drug 5 flurouracil shows greater anticancer 

activity than the isolated compound with an IC50 value of 2.73 and percentage 

viability of 5.29 at 100 µg. The cell growth against various concentrations used for 

the compound and standard were depicted in fig 22 & 23.    

Chalcones mainly belongs to flavonoids family and known as open chain flavonoid in 

which two aromatic rings A and B structurally joined by α,β-unsaturated carbonyl 

system. Plants containing chalcones have been used traditionally as anti-

inflammatory, antioxidant, antimalarial, antimicrobial, antifungal, antitubercular, 

cytotoxic, antiviral, antitumor and chemopreventive agent. 

The IC50 values for prenylated chalcone and having wide range of biological activities 

including anticancer, it ranged from 0.20 μM (towards CCRF-CEMcells) to 195.12 

μM (towards leukemia CEM/ADR 5000 cells) for doxorubicin. It induces apoptosis in 

CCRF-CEM leukemia cells, mediated by caspase activation and the disruption of 

MMP
61

. 
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ACUTE TOXICITY ACTIVE ETHANOLIC EXTRACT OF 

MERREMIA HEDERACEA IN RATS 

 

Determination of acute oral toxicity is usually the initial screening step in the 

assessment and evaluation of the toxic characteristics of all compounds. The types of 

toxicity tests which are routinely performed by pharmaceutical manufacturers in the 

investigation of a new drug involve acute, sub-acute and chronic toxicity. Acute 

toxicity is involved in estimation of LD50 (the dose which has proved to be lethal 

(causing death) to 50% of the tested group of animals). 

 

The acute toxicity study of active ethanolic extract of Merremia hederacea was 

carried out as per (OECD) draft guidelines 423 adopted on 17th December 2001 

received from Committee for the purpose of Control and Supervision of Experimental 

Animals (CPCSEA). The acute toxic class method is based on biometric evaluation 

with fixed doses, adequately separated to enable a substance to be ranked for 

classification purpose and hazard assessment 
62

. 

 

Acclimatization of Animals: 

            Female Wistar rats (130-150g) were maintained under standard laboratory 

condition at the centre for experimental animals in Madras Medical College. Animal 

ethical Committee’s clearance 1917/ReBi/S/16/CPCSEA/25.10.2016 was obtained for 

the study. After seven days of Acclimatization, the 3 animals were housed in labelled 

cages with solid plastic sides and floor with stainless steel grid tops. Animals were 

allowed free access to standard pellet diet and water ad libitum. They were maintained 

in controlled laboratory conditions of 12hours dark/light cycle, 22±2ºC temperatures 

and 45-60% humidity. 

 

Administration of ethanol extract: 

            Three animals were used for the study. Animals made to fast prior to dosing 

(food was withdrawn overnight and water was withdrawn 3hrs before drug 

administration) following the period of fasting. The animals were weighed and the 

extract was administered in a single dose, as 1% suspension in carboxy methyl 

cellulose by oral intubation. Food was withheld for further one hour after the 
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administration of drug. The starting dose level was selected for the study with a dose 

of 2000mg/kg body weight. 

 

 

Observations: 

           

  Animals were observed individually after dosing periodically during the first 30 

minutes to first 24 hours, with special attention given during the first 4 hours and 

daily thereafter, for a total of 14 days.  

       

    The time at which signs of toxicity appear and disappear was observed 

systematically and recorded for each animal. Additional signs of toxicity such as 

changes in bodyweight, skin and fur, eyes and mucus membranes, respiratory system, 

circulatory system, autonomous system and central nervous system, somatomotor 

activity and behaviour pattern were also recorded. Attention was given to observe the 

tremors, convulsions, salivation, diarrhoea, lethargy, sleep and coma. 

     

   The rats were observed regularly for 14 days to note the compound related 

mortality/morbidity or other toxic symptoms. Any mortality during the experiment for 

14 days was observed and recorded. If no deaths were reported, the study was 

repeated with same dose to confirm the results.  
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Table: no 10. Results of acute toxicity in rats on administration of ethanol 

extract of Merremia hederacea (ETMH) at the dose of 2000mg/kg. 

 

OBSERVATION 30 MINS 4 HOURS 24 HOURS 14
th 

DAY 

BODY WEIGHT - - - - 

PRE TERMINAL DEATH - - - - 

CAGE SIDE 

OBSERVATION 

+ + + + 

MOTOR ACTIVITY + + + + 

CONVULSIONS - - - - 

PILORECTION - - - - 

RIGHTING REFLEX + + + + 

LACRIMATION - - - - 

SALIVATION - - - - 

RESPIRATION + + + + 

SKIN COLOUR - - - - 

DIARRHOEA - - - - 

GROOMING - - - - 

SEDATION - - - - 

EXCITATION + + + + 

AGGRESSION + + + + 

 

NOTE: + indicates presence and - indicates absence. 

 

 Discussion: 

The ethanolic extract of Merremia hederacea (ETMH) was found to be non-toxic 

upto the dose of 2000mg/kg and did not cause any death of the tested animals and the 

LD50 value is expected to exceed 2000mg/kg/body weight. 

Since there was no death and behavioural changes observed. The extract was 

considered as safe to administer. From this 1/10
th

 and 1/5
th

 of the dose (200mg and 

400mg) were selected for in vivo studies. 
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IN VIVO ANTIDIABETIC ACTIVITY OF ETHANOL EXTRACT 

OF MERREMIA HEDERACEA IN RATS 

ACCLIMATIZATION OF ANIMALS: 

Animals of either sex of wistar rats (7 to 8 week; 150–190 g), maintained in sanitized 

polypropylene cages (6 per cage) in air conditioned rooms (23 ± 2∘ C, 35–60% 

humidity with 12 h light-dark cycle), were obtained from Animal house, Madras 

Medical College. The rats were fed with pellet diet and water ad libitum. Prior 

approval was obtained from the Institutional Animal Ethical Committee 

(1917/ReBi/S/16/CPCSEA/25.10.2016). They were maintained in controlled 

laboratory conditions of 12hours dark/light cycle, 22±2ºC temperatures and 45-60% 

humidity. 

 

GROUPING OF ANIMALS AND TREATMENT 

30 Wistar rats of either sex (weighing about 150-190g) were selected for this 

experiment. 

Table: no 11. Grouping of animals and Treatment  

 

GROUP 

 

 

DRUG 

 

 

TREATMENT 

 

 

NO. OF ANIMALS 

1 Control Normal saline 6 

2 Disease control Streptozotocin 60mg/kg 6 

3 Standard Glibenclamide 5mg/kg 6 

4 Test Dose 1 Extract – Low dose (200mg/kg) 6 

5 Test Dose 2 Extract – High dose(400mg/kg) 6 

  Total 30 

 

Preparation of 0.1 M Citrate Buffer.  

Accurately weighed quantity of trisodium citrate (1.49 g) was dissolved in sufficient 

milli Q water to produce 100 mL and was adjusted to pH 4.5 with HCl. 
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Preparation of STZ and Nicotinamide Solution.  

STZ is freely soluble in water and saline, but it is unstable in both. It is stable in 0.1 M 

citrate buffer. A solution of STZ of appropriate strength (depending on the required 

total dose per animal) was prepared by dissolving weighed quantity of STZ in freshly 

prepared ice cold citrate buffer and was administered i.p. in volumes of ∼2 mL/kg 

(dose: 60 mg/kg). STZ was freshly prepared because it is unstable. Nicotinamide was 

dissolved in normal saline to yield a strength that is appropriate for administration . 

Experimental induction of diabetes:  

Diabetes was induced by STZ (60 mg/kg), 15 min after the intraperitoneal 

administration of nicotinamide (120 mg/kg). Diabetic rats were permitted to intake of 

10% glucose solution overnight to overcome the initial drug induced hypoglycaemic 

death. After 7 days rats showing FBG between 180 and 220 mg/dL were considered 

diabetic and included in the study.  Active extract and standard drug were 

administered orally by gastric intubation using a force feeding needle to the respective 

groups of rats for 21days.
 

 

Biochemical estimation: 

After overnight fasting the blood was withdrawn from the tail vein about 0.1 mL and 

fasting blood glucose level was checked by using accu-check glucometer on  1, 7, 14 

and 21day period. Animal body weight is also recorded before and after the treatment. 

At the end of the experiment 21
st
 day, rats were fasted overnight and blood samples 

were withdrawn through the retro-orbital plexus (2 to 5 mL) under light isoflurane 

anaesthesia using a glass capillary tube and collected in a Vacutainer blood collection 

tubes. Blood was allowed to clot and serum separated by centrifugation at 4000 rpm 

for 10 minutes.  LDL-C and HDL-C were measured by enzymatic colorimetric 

methods using commercial kits. 

       After the collection of blood samples animal was sacrificed and pancreas was 

isolated for histopathological studies.
63

 

Parameters: 

 Fasting Blood glucose level 

 Body weight 

 Serum HDL-C and  LDL-C 
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Statistical analysis  

Data is reported as Mean ± SEM. Statistical comparisons were determined by analysis 

of variance (ANOVA) and means were separated using Dunnett’s t- test. 

Table: no: 10 Effect of ethanol extract of Merremia hederaceae (ETMH) on 

fasting blood glucose level in STZ induced diabetic rats 

 

All values are expressed as mean ± SEM 

*** P<0.001 vs Group II, significant by ANOVA followed by Dunnett’s t – test (At 

200 & 400mg/kg (ETMH), Negative control.  

** P<0.01 vs Group III, significant by ANOVA followed by Dunnett’s t – test. 

(Negative control). 

*** P<0.001 There was a significant increase of FBG in STZ induced group of rats 

when compared with normal control group. 

P<0.001, P<0.01, P<0.001 Treatment with positive control, low dose and high dose of 

ETM,H groups showed significant decrease in FBG level when compared with 

negative control group(STZ induced) 

 

Treatment Day 0 Day 1 Day 7 Day 14 Day 21 

Normal control (Saline) 98±2.42 99±2.12 100±2.03 103±1.76 99±2.21 

Disease control (STZ 

Induced) 

100±2.82 275±4.33 

** 

286±3.46 295±4.27 

 

303±3.99 

** 

Positive control 

STZ + Glibenclamide 

102±1.41 212±3.86 

*** 

141±2.84

** 

119±2.95 

*** 

99±2.33 

*** 

STZ + extract Low dose 

(200mg/kg) 

103±2.45 231±2.55 

*** 

160±2.18

*** 

123±2.97 

*** 

106±2.85 

*** 

STZ + extract High dose 

(400mg/kg) 

105±1.64 209±3.70 

*** 

157±2.73

*** 

123±1.65 

*** 

102±1.84 

   *** 
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Fig no: 17 Effect of ETMH on fasting blood sugar level in STZ induced diabetic 

rats 
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Table no 11.  Effect of ETMH on body weight in STZ induced diabetic rats 

Treatment Day 0 Day 1 Day 7 Day 14 Day 21 

Normal control 

(Saline) 

165±2.47 168±2.77 171±2.46 175±2.84 180±2.33 

Disease control (STZ 

Induced) 

163±2.17 157±1.78 146±1.02 129±1.11 113±1.51 

** 

Positive control 

STZ + 

Glibenclamide 

166±2.67 172±2.57 179±3.28 187±2.86 201±3.83 

*** 

STZ + extract Low 

dose (200mg/kg) 

161±1.55 163±2.11 174±2.12 185±1.98 189±1.23 

** 

STZ + extract High 

dose (400mg/kg) 

165±3.59 169±.978 176±4.45 188±4.43 

 

193±4.49 

*** 

 

 

All values are expressed as mean ± SEM 

At 400mg/kg (ETMH), *** P<0.001 vs Group III, Significant by ANOVA 

followed by Dunnett’s t – test. 

The result showed that, 

 There was significant ** (p< 0.01) reduction in body weight in negative 

control group compared with normal control group  

               *** (p<0.001), ** ( p<0.01), ***( p<0.001) for group III, IV and V    

respectively. Here showed significant increase in body weight compared with disease 

control. When treatment with positive control low dose and high dose of ETMH 
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Fig no: 18 Effect of ETMH on body weight in STZ induced diabetic rats   
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     Table no 12.  Effect of ETMH on LDL-C and HDL-C in  

                              STZ induced diabetic rats on 21
st
 Day 

 

 

 

 

 

 

 

 

 

 

 

All values are expressed as mean ± SEM 

LDL Cholesterol 

At 400mg/kg of ETMH *** P<0.001 vs group III (positive control), significant by 

ANOVA followed by Dunnett’s t – test 

At 200mg/kg of ETMH ** P<0.01 vs group III (positive control), significant by 

ANOVA followed by Dunnett’s t – test 

HDL Cholesterol  

At 400mg/kg ***P<0.001, vs Group III, significant by ANOVA followed by 

Dunnett’s t – test. 

At 200mg/kg ETMH ** P<0.01 vs Group III, significant by ANOVA followed by  

Dunnett’s t – test 

 

 

 

Test LDL-C HDL-C 

Normal control 88±1.68 

 

60±1.40 

 

Diabetic control 

STZ induced 

178±2.39 *** 

 

27±1.08 ** 

 

Standard 

STZ + Glibenclamide 

83±4.1.73*** 

 

58±1.67 *** 

 

STZ + ETMH  

(200mg/kg) 

103±1.52 ** 

 

34±1.20 ** 

 

STZ + ETMH 

(400mg/kg) 

94±1.42 *** 

 

54±1.65*** 
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Fig no. 19:  Effect of ETMH on LDL-C in STZ induced diabetic rats on 21
st
 Day 

             
          

Fig no. 20:  Effect of ETMH on HDL-C in STZ induced diabetic rats on 21
st
 Day 
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Results and Discussion 

Effect of ETMH in fasting blood sugar level in STZ induced diabetic rats. 

Administration of STZ resulted in significant (P < 0.001) increase in mean 

blood glucose level on day 1, 7, day 14 & 21. Post treatment with an ETMH in STZ 

induced rats significantly reduce (P <0.001) the increase of blood glucose level as 

compared to group II. The Administration of ETMH produces dose dependent effect 

as the high dose (400mg/kg) shows more significant anti diabetic activity than 

200mg/kg. Treatment with glibenclamide after induction of diabetes significantly (P< 

0.001) reduced the increased blood glucose level as compared to group II (Table 

no.12, Fig: no. 24 )  

 

Discussion  

The objective of treatment in diabetic patient is to lower blood glucose to normal 

level. In the present study, ETMH showed significant lowering of blood glucose level, 

an index of diabetic control. STZ-induced diabetes is one of the widely used animal 

models that mimic the human diabetes mellitus. In addition, STZ generates potential 

free radicals such as nitric oxide (NO) by intracellular metabolism of STZ and 

precipitate further β-cells DNA damage by strand break. 

The concentration of blood glucose was significantly increased in STZ induced 

diabetic as compared to normal control. Administration of ETMH (200 mg/kg and 

400 mg/kg) significantly reduced the raised blood glucose level in STZ induced 

diabetic rats and the lowering was almost comparable to glibenclamide 5mg/kg.) 

(Table no.12). Further, this antidiabetic activity of ETMH was associated with an 

increase in the serum insulin level revealed that ETMH may stimulate insulin 

secretion from regenerated β cells and remaining β-cells. The blood glucose lowering 

effect of the ETMH could be due to the presence of flavonoid and phenolic 

compounds as reported in the preliminary phytochemical screening. These findings 

were also supported by the previous experimental findings wherein they reported the 

blood glucose lowering effect of flavonoids.
64,65
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            Effect of ETMH in Body weight in STZ induced diabetic rats. 

          Table 13, fig 25, describes the changes in the body weight of the control and 

experimental rats treated with ETMH and glibenclamide. The body weight of the 

STZ-induced diabetic rats was lowered than that of the normal control groups at 7, 14 

& 21
st
 day. But the administration of ETMH of 400mg/kg, significantly increase of 

the body weight on 7,14, 21
st
 day compared to standard glibenclamide. 

Low Density Lipoprotein (LDL) 

As illustrated in table 14 & fig 26, there was a significant rise (P< 0.001) in 

LDL level in STZ induced diabetic rats when compared to normal group. The 

administration of glibenclamide has significant (P< 0.001) lowering of LDL level at 

21st day. The administration of ETMH, have showed a significant lowering (P < 

0.001) of LDL level when compared to positive control.  

Patients with type 2 diabetes show reduced turn-over of their LDL particles 

with a reduction of catabolism, leading automatically to increased LDL plasma 

residence time. A^|^|6\6\6\                           ugmented LDL residence time in plasma 

is likely to promote cholesterol deposition in the arterial wall  

High Density Lipoprotein (HDL) 

As illustrated in table 14 & fig 27, there was a significant decline (P< 0.001) 

in HDL level in STZ induced diabetic rats when compared to normal group. The 

administration of glibenclamide has significant (P< 0.001) increase of HDL level 

compared to group II. The administration of ETMH at 400mg/kg has showed a 

significant increase (P < 0.001) of HDL level on 21
st
 day when compared to positive 

control. 

Type 2 diabetes is associated with decreased plasma HDL cholesterol levels 

related to reduction of the HDL 2 subfraction. Reduced HDL 2 level, in type 2 

diabetes, has been shown to be correlated with both hypertriglyceridaemia and 

obesity. The decrease in HDL cholesterol, noted in patients with type 2 diabetes, is 

due to increased catabolism of HDL particles.
66
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HISTOPATHOLOGICAL STUDIES 

           At the end of 21
st
 day experiment, the selected rats were anesthetized by high 

dose of isoflurane and the animals were scarified and abdominally dissected. A 

portion of pancreatic tissue was dissected out and fixed in 10% buffered neutral 

formalin for 24 hours. After fixation the tissues were embedded in paraffin wax. 

About 5 microns thickness sections were prepared with microtome and mounted on 

clean glass slides and then they were de paraffinized in xylene twice for 5 minutes 

and then rehydrated with graded alcohol and stained with haematoxylin and eosin 

(H&E) dye. The stained sections were examined and photographed by using 

microscope.
67

 

 

    

 

STZ Induced Diabetic rat                                         Standard (Glibenclamide   

 

       

 

             Low Dose (200mg/kg)                                     High Dose (400mg/kg) 

             Fig: no 28. Histopathology of STZ Induced Diabetic Rats Pancreas 
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Results: 

STZ induced diabetic rat Pancrease: 

          Streptozotocin treated groups showing reduce islet of Langerhans. Low dose 

(200mg/kg), High dose (400mg/kg) and Glibenclamide (standard) treated groups 

showing recovery of islet of Langerhans. The number of islets cells was 

comparatively higher in 400mg/kg than low dose 200mg/kg. Hence the number of 

islets cells increases in dose dependent manner. 
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SUMMARY 

In this present research, A potent anti diabetic plant Merremia hederacea has been 

selected. The literatures pertaining to phytochemical and the antidiabetic activity of 

this plant are very scarce. Hence an attempt has been made to evaluate the in vitro 

and in vivo anti diabetic activity of Merremia hederacea and to isolate the active 

constituent responsible for anti diabetic activity. The isolated pure compound has 

been attempted for molecular docking analysis. 

Soxhlet Extraction & Preliminary Phytochemical Screening 

The dried powder of leaves was extracted sequentially by hot continuous percolation 

method by soxhlet apparatus using Petroleum ether, chloroform, ethyl acetate and 

ethanol as solvent. Among all extracts, ethanol extract has the highest percentage 

yield of 18.65%. Preliminary phytochemical screening were carried out and found 

that ethanol extract shows the presence of glycosides, flavonoids, tannins and 

Phenolic compounds. 

In vitro Antidiabetic activity  

All the extracts were subjected for in vitro anti diabetic activity against alpha amylase 

and alpha glucosidase. It was found in table 4 & 5, the ethanol extract shows greater 

percentage inhibition than other extracts in both enzyme assay with 91.44% and 

85.50% respectively. The presence of flavonoids, phenolic compounds in ethanolic 

extract of Merremia hederaceae may act against diabetes mellitus. Mainly two 

carbohydrate hydrolyzing enzymes (α-amylase and α-glucosidase) are responsible for 

postprandial hyperglycemia. α-amylase begins the process of carbohydrate digestion 

by hydrolysis of 1, 4-glycosidic linkages of polysaccharides (starch, glycogen) to 

disaccharides and α-glucosidase catalyzes the disaccharides to monosaccharides, 

which leads to postprandial hyperglycaemia. Hence ethanol extract of Merremia 

hederaceae inhibits the α-amylase and α-glucosidase and control the hyperglycaemia 

as they delay carbohydrate digestion, which consequently reduce the postprandial 

plasma glucose level. 

Isolation by Column Chromatography   

Hence ethanol extract is bioactive than our extracts and considered for column 

chromatographic isolation, to isolate the anti diabetic component present in the 

extract. Wet packing method was followed and gradient elution technique was 
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adopted using various solvent systems such as Hexane, Hexane: chloroform, 

chloroform, chloroform: ethyl acetate, ethyl acetate, Ethyl acetate: methanol to 

separate the eluate. When the mixture of solvent system used, the ratio of mixtures are 

prepared as 100%, 90:10, 80:20, 70:30, 60:40, 50:50, 40:60, 30:70, 20:80 and 10:90.  

The reddish brown band was eluted in fraction 25 -29 in the solvent system ethyl 

acetate:  methanol: glacial acetic acid (60.30:10). The fractions 25 -29 were tested in 

TLC with various solvent systems. The fractions 25- 29 show similar Rf values and 

shows single spot and were mixed together and evaporated to yield an amorphous 

compound. The compound is a yellow amorphous powder. FeCl test was performed 

and shows positive (dark green) and it is characterized by UV, IR 1H NMR & LCMS. 

Ultraviolet spectroscopy (MeOH) λmax  253.0, 278.0 nm.  Infra red spectroscopy (KBr 

Pellet) Aromatic O-H Stretching 3440.78 cm
-1

,
  

C =O (Chelated carbonyl group) 

1643.23 cm
-1

,
   

CH3  1342.36 cm
-1

 , CH – Aliphatic 2877 cm
-1

, Ketones (Carbonyl 

group) 1728 cm
-1

 

 The molecular formula was determined to be C20H20O4 from its HPLC + PDA+ MS 

with a molecular ion peak, [M]
+ 

at 325.10 [M+ H]
+ 

and other fragments at 269.95, 

369.05. The molecular ion peak and fragments matched with a compound, 2′,4,4′- 

Trihydroxy-3′-(3-methyl-2-butenyl)-chalcone. 

   
1
H NMR (Bruker DMSO 500 MHz): δ 1.642 (3H, s), δ 1.753 (3H, s ), δ 3.25 (2H, d), 

δ 5.201 (1H, t),   δ 6.501 (1H, d), δ6.850 (2H, d),   δ7.254 (1H, d), δ 7.710 (1H, d), δ 

7.772 (2H, d), δ 8.131, δ 10.12 (1H,s),  δ2.50 (DMSO solvent peak.). Hence the 

isolated compound from the ethanol extract of Merremia hederacea is elucidated as 

2′,4,4′- Trihydroxy-3′-(3-methyl-2-butenyl)-chalcone. 

Molecular docking study of 2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone 

against diabetic target protein (alpha glucosidase) 

  Molecular docking study of 2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone was 

determined against the target with the PDB ID 3L4W. In this docking study, we 

present an approach to control blood glucose levels in individuals with type 2 diabetes 

by targeting maltase- glucoamylase and intestinal glucosidases using a ligand (2',4,4'-

trihydroxy-3'–(methyl-2-butenyl) chalcone) isolated from Merremia hederacea. One 

of the intestinal glucosidases targeted the N-terminal catalytic domain of maltase-

glucoamylase (ntMGAM) which is responsible for the hydrolysis of terminal starch 
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products into glucose. Hence to slow down the glucose level and targeted the 

ntMGAM. Previously acarbose and miglitol were found to be potent inhibitors alpha 

glucosidase having poly hydroxy groups in their structure . Hence novel ligand 

(2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) which has three hydroxyl groups 

and is chalcone based isolated from Merremia hederacea was docked for the binding 

sites of alpha glucosidase.  

From the previous literature review of the docking results of a standard ligand 

(Miglitol) had a binding energy of -8.04 kcal/mol. The hydrogen bond forming amino 

acid residues of the target protein was found to be His 626 and Asp 232.Excluding 

hydrogen interaction, the ligand was also formed nine electrostatic interaction with 

the amino acids. 

The ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) was predicted to 

have better binding energy of –11.28 kcal/mol as compared to standard drug. It forms 

hydrogen bond interactions with amino acid residues of the target protein, Lys534, 

Ala 537, Lys 776, Arg 520, Gly 533(fig 17 & 18) 

 

Molecular docking study of 2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone 

against cancer target protein. 

From the previous literature review of the docking results of a standard ligand (5-

Fluoro uracil) had a binding energy of -4.67 kcal/mol. The hydrogen bond forming 

amino acid residues of the target protein was found to be Leu 103 and Val 37.  

The ligand (2',4,4'-trihydroxy-3'–(methyl-2-butenyl) chalcone) was predicted to 

have better binding energy of – 9.56 kcal/mol as compared to standard drug. It forms 

hydrogen bond interactions with amino acid residues of the target protein Asn 165, 

Asp 239, Asp 219, Gly 196. (fig 19 & 20) 

Chalcone O-methyltransferase (ChOMT) and isoflavone O-methyltransferase (IOMT) 

are potent targets for antitumour activity and are SAM dependent methyltransferases 

whose crystal structures with flavonoids have been determined.  

Alpha glucosidase inhibition of 2′,4,4′- Trihydroxy-3′-(3-methyl-2-butenyl)-

chalcone 

The isolated compound, 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl)chalcone, was 

evaluated against alpha glucosidase inhibition assay as shown in table 8 & fig 21. It 

was found that the compound showed good anti diabetic activity with a percentage 
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inhibition of 80.57% at 320µg compared to the standard voglibose with a percentage 

inhibition of 94.49 at 320 µg.  

2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl) chalcone is a class of flavonoids, 

possess good antidiabetic activity. Chalcones are secondary metabolites of terrestrial 

plants and precursors of the flavonoids biosynthesis, have been used for a long time in 

traditional medicine due to their wide-range of biological activities, from which the 

anti-diabetic activity stands out. Chalcones are, undoubtedly, promising anti-diabetic 

agents, and some crucial structural features have already been established. From the 

structure-activity relationships analysis, it can generally be stated that the presence of 

hydroxyl, prenyl and geranyl groups in their skeleton improves their activity for the 

evaluated antidiabetic targets. 

 

In vitro anticancer activity of 2′,4,4′- Trihydroxy-3′-(3-methyl-2-butenyl)-

chalcone 

In vitro anticancer activity was carried out for the isolated compound 2′, 4, 4′ -

Trihydroxy-3′-(3-methyl-2- butenyl)   chalcone against liver cancer cell line 

(HepG2) as shown in table 9. The percentage viability at 100µg of the isolated 

compound was found to be 18.75 and an IC50 value of 10.57. The 2′, 4, 4′ -

Trihydroxy-3′-(3-methyl-2- butenyl) chalcone shows good anticancer activity 

against liver cancer cell line. The standard drug 5 flurouracil shows greater anticancer 

activity than the isolated compound with an IC50 value of 2.73 and percentage 

viability of 5.29 at 100 µg. The cell growth against various concentrations used for 

the compound and standard were depicted in fig 22 & 23. 

Chalcones mainly belongs to flavonoids family and known as open chain flavonoid in 

which two aromatic rings A and B structurally joined by α,β-unsaturated carbonyl 

system. Plants containing chalcones have been used traditionally as anti-

inflammatory, antioxidant, antimalarial, antimicrobial, antifungal, antitubercular, 

cytotoxic, antiviral, antitumor and chemopreventive agent. 

 

Acute toxicity study of ethanolic extract of Merremia hederacea (ETMH) 

The active ethanolic extract of Merremia hederacea was found to be non-toxic upto 

the dose of 2000mg/kg and did not cause any death of the tested animals and the 

LD50 value is expected to exceed 2000mg/kg/body weight. Since there were no death 

and behavioural changes observed. The extract was considered as safe to administer. 
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From this 1/10
th

 and 1/5
th

 of the dose (200mg and 400mg) were selected for further 

studies. 

In Vivo anti diabetic activity of ethanolic extract of Merremia hederacea   

Determination of fasting blood sugar level in STZ induced diabetic rats.  

Administration of STZ resulted in significant (P < 0.001) increase in mean blood 

glucose level on day 1, 7, day 14 & 21. Post treatment with an ETMH in STZ induced 

rats significantly reduce (P <0.001) the increase of blood glucose level as compared to 

group II. The Administration of ETMH produces dose dependent effect as the high 

dose (400mg/kg) shows more significant anti diabetic activity than 200mg/kg. 

Treatment with glibenclamide after induction of diabetes significantly (P< 0.001) 

reduced the increased blood glucose level as compared to group  III (Table no.12, Fig: 

no. 24 ) 

The concentration of blood glucose was significantly increased in STZ induced 

diabetic as compared to normal control. Administration of ETMH (200 mg/kg and 

400 mg/kg) significantly reduced the raised blood glucose level in STZ induced 

diabetic rats and the lowering was almost comparable to glibenclamide 5mg/kg.) 

(Table no.10). Further, this antidiabetic activity of ETMH was associated with an 

increase in the serum insulin level revealed that ETMH may stimulate insulin 

secretion from regenerated β cells and remaining β-cells. The blood glucose lowering 

effect of the ETMH could be due to the presence of flavonoid and phenolic 

compounds as reported in the preliminary phytochemical screening. 

Determination of Body weight in STZ induced diabetic rats. 

Table 13, fig 25, represents the changes in the body weight of the control and 

experimental rats treated with ETMH and glibenclamide. The body weight of the 

STZ-induced diabetic rats was lowered than that of the normal control groups at 7, 14 

& 21
st
 day. But the administration of ETMH of 400mg/kg, significantly increase of 

the body weight on 7,14, 21
st
 day compared to standard glibenclamide. 

   Determination of LDL & HDL in STZ induced diabetic rats.  

   There was a significant rise (P< 0.001) in LDL level in STZ induced diabetic rats 

when compared to normal group. The administration of glibenclamide has significant 

(P< 0.001) lowering of LDL level at 21st day as shown in table 14 & fig 26. The 

administration of ETMH, have showed a significant lowering (P < 0.001) of LDL 

level when compared to positive control.  
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Patients with type 2 diabetes show reduced turn-over of their LDL particles with a 

reduction of catabolism, leading automatically to increased LDL plasma residence 

time. Augmented LDL residence time in plasma is likely to promote cholesterol 

deposition in the arterial wall  

High Density Lipoprotein (HDL) 

There was a significant decline (P< 0.001) in HDL level in STZ induced diabetic rats 

when compared to normal group. The administration of glibenclamide has significant 

(P< 0.001) increase of HDL level compared to group II as shown in  table 14 & fig 

27,  The administration of ETMH at 400mg/kg has showed a significant increase (P < 

0.001) of HDL level on 21
st
 day when compared to positive control. 

   Type 2 diabetes is associated with decreased plasma HDL cholesterol levels related to 

reduction of the HDL 2 subfraction. Reduced HDL 2 level, in type 2 diabetes, has 

been shown to be correlated with both hypertriglyceridaemia and obesity. The 

decrease in HDL cholesterol, noted in patients with type 2 diabetes, is due to 

increased catabolism of HDL particles. 

   Histopathological studies 

 Streptozotocin treated groups showing reduce islet of Langerhans. Low dose 

(200mg/kg), High dose (400mg/kg) and Glibenclamide (standard) treated groups 

showing recovery of islet of Langerhans. The number of islets cells was 

comparatively higher in 400mg/kg than low dose 200mg/kg. Hence the number of 

islets cells increases in dose dependent manner. (fig 28) 
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CONCLUSION 

 

According to current educated guess, the global human population emerges to be in 

the midst of an epidemic of diabetes. In spite of the enormous steps that have been 

made in the perceptive and executive of diabetes, the disease and disease related 

problems are increasing spontaneously. Equivalent to this, current investigations and 

studies in understanding the pathophysiology of the disease process have opened up 

numerous novel avenues to recognize and expand new therapies to fight the diabetic 

condition. Simultaneously, phytochemicals bioactive compounds identified from 

traditional medicinal plants are presenting an exhilarating prospect for the 

improvement of novel therapeutics. This has step up the world wide effort to exploit 

and collect those medicinal plants that bear considerable amount of potential 

phytochemicals presenting multiple beneficial effects in combating with diabetes and 

diabetes-related difficulties. Therefore, as the disease is progressing alarming rates, 

there is an urgent need of identifying indigenous natural resources in order to procure 

them, and study in detail, their potential on different newly identified targets in order 

to develop them as new therapeutics. In these regard we have made an attempt to 

investigate the in vitro and in vivo anti diabetic activity of Merremia hederacea. The 

isolated pure compound has been attempted for molecular docking studies.  

From all these observations it is concluded that ethanol extract of Merremia 

hederacea possess significant antidiabetic activity. The concentration of blood 

glucose was significantly increased in STZ induced diabetic as compared to normal 

control. Administration of ETMH (200 mg/kg and 400 mg/kg) significantly reduced 

the raised blood glucose level in STZ induced diabetic rats and the lowering was 

almost comparable to glibenclamide 5mg/kg.). The blood glucose lowering effect of 

the ETMH could be due to the presence of novel chalcone (2',4,4'-trihydroxy-3'–

(methyl-2-butenyl) chalcone) which is isolated from the leaf of this plant by column 

chromatography in this study. The isolated compound is characterized by 

HPLC/PDA/MS, 
1
HNMR & IR.  

            From the observations of molecular docking studies and in vitro anti diabetic 

and anti cancer activity of the isolated compound (2',4,4'-trihydroxy-3'–(methyl-2-

butenyl) chalcone) it has been concluded that chalcones are, undoubtedly, promising 

anti-diabetic agents, and some crucial structural features have already been 
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established. From the structure-activity relationships analysis, it can generally be 

stated that the presence of hydroxyl, prenyl and geranyl groups in their skeleton 

improves their activity for the evaluated antidiabetic targets. The compound shows 

greater percentage inhibition for alpha glucosidase at 320µg compared to standard and 

has a good docking score of -11.28 Kcal
-1

 against diabetic target protein, alpha 

glucosidase.   

The 2′, 4, 4′ -Trihydroxy-3′-(3-methyl-2- butenyl) chalcone shows good anticancer 

activity against liver cancer cell line (HepG2) compared to the standard 5 fluro Uracil. 

The compound has a docking score of – 9.56 kcal/mol against cancer target protein. 
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FUTURE PROSPECTS 
 
 
 

 The isolated 2, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl) chalcone  will be 

focused for lipid encapsulation nanotechnology and will be investigated in 

future for effective drug delivery system. 

  

 The isolated 2, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl)chalcone will be 

evaluated in future for enzyme inhibition assay of Protein tyrosine 

Phosphatase 1b ( the diabetic target protein). 

 

 The isolated 2, 4, 4′ -Trihydroxy-3′-(3-methyl-2-butenyl)chalcone will be 

evaluated in future for in vitro anti tubercular activity. 
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